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ABSTRACT 
 
To assist the designer during the different design stages, plenty of technological 

advances have occurred in computer science during the past years. BIM methodology is 
primarily consolidated in the building sector, however is having a great incidence in the 
civil engineering environment improving the process constantly.  

 
The project is a concrete application of BIM methodology focused on the 

implementation of Maintenance Plan and on a collaborative work. The thesis 
development was based on Variante di Demonte project, which is a real case that it has 
not yet been built.  The main goal of the thesis is the implementation of the viaduct 
maintenance program using BIM procedure and to investigate how work in a 
collaborative way with the software selected. The paper is divided into different parts 
that clearly describe the methodology utilized. Through the application of several 
software, a 4D bridge model will be obtained. 

 
The first part consists in a description of the case study (Variante di Demonte 

project) and in a theorical research about BIM characteristics and its implementation, 
with the objective of providing an initial overview of the BIM methodology. The second 
part includes an explanation of the steps that have been followed for the road context 
modelling, the result has been used as a base to locate the bridge structure. The third 
part is regarding the creation of the parametric model of the bridge, with a specific focus 
on the interoperability between the software that have been used. Finally, in the last 
part of the thesis the bridge elements are associated with the timetable and information 
of the maintenance plan. It has also been generated a simulation with the aim of enabling 
the visualization of the progress of the maintenance activities over time.  In addition, it 
has been simulated the communication and collaboration between stakeholder through 
the definition of a central model, which contains information inherent to the models 
created by each part. 
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1. INTRODUCTION 

              1.1 The state road S.S.21 “of the Colle della Maddalena” 

The state road S.S.21 "of the Colle della Maddalena", under the jurisdiction of the 
ANAS S.p.A, is an important transalpine connection route, guaranteeing accessibility to 
the French territory through the pass of the Colle della Maddalena. 

Configuring itself as a road of international connection and given the presence of 
industrial and tourist facilities in the Stura valley, besides being affected by normal 
downstream traffic, it is characterized by important commercial and industrial traffic 
volumes. 

The major problems are found in particular in crossing the urban centers of 
Demonte, Aisone and Vinadio. The narrow section of the carriageway and the presence 
of curves and bottlenecks cause considerable criticality circulation in terms of safety and 
fluidity, as well as for the integrity of the buildings adjacent to the roadway. 
 

              1.2 Project to carry out 

To avoid the problems that generate the cross of this road in the urban center of 
Demonte, a variant of 2720m was projected. This variant will be connecting with the 
state road S.S.21, developing mainly in the agricultural area. 

This new road will be connecting with the state road S.S.21 through two 
roundabouts (East and West), and it will be composed of:  

- two viaducts: Perdioni (324m) and Cant (135m)  
- a tunnel of 638m   

Part of this road will be constructed with filling formation. 

 

 
        Figure 1.1- Variante di Demonte location 
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              1.3 A.N.A.S 

A.N.A.S (acronym that originally indicated the “Azienda Nazionale Autonoma delle 
Strade”) is a public, efficient, innovative, and internationally open industrial company 
that was founded in 1946. Since 2018 this Italian company integrate the “Ferrovie dello 
Stato Italiano” group. 

The company takes care of the roads from the design, from the feasibility study 
and the environmental impact assessment, to the construction and the subsequent 
ordinary and extraordinary maintenance. 

A.N.A.S's 2017 financial statements closed with a profit of € 28.1 million, making it 
one of the most efficient road operators in Italy.1 

              1.4 Variante Demonte case study 

The thesis study will be based on a part of this variant, between sections 0+000 
and 1+1350. With the information obtained from ANAS it was possible to understand the 
project main features. 

The main goal of this research will be defining a methodology in order to linking 
the viaduct and its elements with a maintenance plan being able to access to information 
related to the tasks to be carried out, and to their schedules, making use of BIM (Building 
Information Modeling) technology. In order to achieve this goal, the thesis was divided 
into three main parts: modeling the terrain and new road, modeling the viaduct and 
developing the BIM process implementation focused on a maintenance plan. 

 

 
        Figure 1.2- Case study area 

              1.5 Building information modeling 

                        1.5.1BIM introduction  
 
Architecture and construction have always relied on drawing for design data 

representation. Since the beginning of history, 2D and 3D architectural and engineering 

                                                           
1 https://www.stradeanas.it/it/azienda 

https://www.stradeanas.it/it/azienda
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drawings have been evolving in order to obtain a better interpretation and optimize the 
construction process. 

To assist the designer during the different design stages, plenty of technological 
advances have occurred in computer science during the past years. 

Building Information Modeling is a process of creation and management of project 
information all through its three steps: before, during and after construction. The result 
of this process is an accurate digital model that contains all the information related to 
the building during its life cycle. 

The information provided to the BIM model comes from different types of 
software, modeling programs, structural calculation, MEP, budget software, energy 
behavior analysis, etc. 

 When completed, the computer-generated model contains precise geometry and 
relevant data needed to support the construction, fabrication, and procurement 
activities needed to actualize the building. 

This new method of work integrates all the agents involved in the building process. 
The benefits obtained by this working method have exceeded expectations and 

even some governments are already demanding BIM implementation. 
 
Building Information Modelling is generally used in order to: 

 
 -  Provide support for the project’s decision-making process  
 -  Parties have a clear understanding of the project objectives & interfaces with 

other related trades/stakeholders  
                -  Visualize design solutions  

-   Assist in design and the coordination of designs  
-   Increase and secure the quality of the building process and the final product  
-   Make the process during construction more effective and efficient  
-   Improve safety during construction and throughout the building’s lifecycle  
-   Support the cost and lifecycle analysis of the project  
-  Support the transfer of project data into data management software during 

operation 2 

 

Nowadays, BIM is used mostly during the design phase of the building project. 
Given that BIM is still in development with respect to its application in the different 
phases of the life cycle of a project, its benefits have not been seen in equal levels in each 
one of them. 

 
 
 
 

                                                           
2 “Building Information Modelling – Belgian Guide for the construction Industry” by ADEBVBA, 

Edition 2015 
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Through a survey done by MHC’s Business Value of BIM SmartMarket Report, the 
following BIM implementation results were obtained:  

 

 
                                                         Figure 1.3- BIM implementation by construction phases 

                        1.5.2 BIM around the world 

 
BIM methodology is evolving throughout the entire world. Government policies for 

BIM implementation signify a great change in construction methodology, forcing 
companies to modify their traditional construction methodologies. 

Although there has been a strong diffusion of the BIM methodology in Europe, few 
countries have a specific norm for its implementation. 

Germany in 2012 published the BIM Guide for Germany and, in 2015, the Federal 
Ministry of Transport and Infrastructure created the portal Plattform Digitales Bauen 
with the aim of collecting ideas, projects and contributions for the creation of national 
legislation. BIM legislation should be launched in 2020 

France-Spain: there is no reference legislation, even if the original intention for 
France was to make one by the end of 2017, while for Spain it is 2018. However, in many 
public tenders, as is often the case in Italy, the contracting they require the use of BIM. 

The United Kingdom in 2015 launched the BIM Protocol v.2.1 and there are well-
defined protocols with reference validation models. It is the only country in Central 
Europe that has regulations and guidelines for designers. 

The Netherlands lacks legislation for public tenders, despite the fact that, as of 
2013, there is one that foresees the use of BIM for the management of facilities. 
          Sweden-Finland-Norway-Denmark: the countries of northern Europe are the most 
advanced when it comes to BIM. These states have very specific rules (the Danish BIM 
Mandate or the Common Finnish BIM Requirements) aimed at defining the general 
principles of design, management and use of BIM models. 
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Singapur, has implemented the world’s first BIM-based rapid building permitting 
system.  The   Building and Construcion Authorty (BCA) in 2008 that implemented “e-
submission, the world’s first model-based submission system, which streamlines the 
process for regulatory submission. Project teams only need to submit one building 
information model, which contains all of the information needed to meet the 
requirements of Singapore’s regulatory agencies. 

United States was the first country to encourage BIM technology in its construction 
policies and is nowadays one of the countries in which BIM has been integrated the most. 
In 2003, the General Services Administration established the National 3D-4D-BIM 
Program. This program established policy mandating BIM adoption for all Public Building 
Service projects. Today, 72% construction firms in the US are believed to be using BIM 
technologies for significant cost savings on projects. 

The government of South Korea since 2010 has been adopting policies to increase 
the scope of BIM-mandated projects. They have allocated about 6 million to construe 
open BIM-based building design standards and information technology. In addition, 
since 2016 they have made BIM mandatory for all projects in the public sector that 
exceed 50 million. 

In recent years there has been a strong increase in the BIM Implementation Levels. 
In 2012, users at Low / Moderate BIM implementation predominated, while the trend 
today is users at high / very high BIM implementation. As can be seen in the following 
image extracted from Dodge Data and Analytics: 

 
                                                 Figure 1.4-BIM Implementation levels 

 
In what awaits the Latin American region, it is expected in 2020 a growth of 11% in 

the BIM market. However, this is not happening homogeneously, with Colombia, Chile, 
Brazil and Peru being the countries with the greatest implementation of this 
methodology while, for example, in Argentina it is just beginning to talk about BIM. 

In Chile, the "Build 2025" Strategic Program has promoted the BIM Plan, which 
aims to promote its use in both public institutions and the private sector. It is expected 
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that in the year 2020 the BIM methodology will become obligatory for all public works 
and by 2025 its implementation will be complete in the private sector. 

In Colombia, although there is great knowledge on the subject, there is no BIM 
implementation standard. The same happens with Ecuador and Panama where there is 
no public initiative and the big players of the BIM are private companies.3 

                        1.5.3 BIM Dimensions 
 

It is possible to organize the different design - management phases of an 
infrastructure with the phases of maintenance and dismantling of it, in a work dynamic 
in which 7 dimensions can be distinguish: 

 

• 1D: The idea 
The initial condition of the structure and the location are defined, the geometry, 

costs and volumes first estimates are made it. 

• 2D: The sketch 
The generic feature of the project like the approach of the materials, the 

definition of the structural and energy loads, and the establishment of the bases for 
the general sustainability of the project are determined. 

• 3D:  Modelling 
It is the geometric modeling of the infrastructure in 3D format from all the 

information collected, though the use of animations or renders. This model will be the 
basis for the rest of the life cycle of the project; it is not just a visual presentation but 
also an incorporation of all the information that will be needed for the following BIM 
dimensions. Is the process of creating graphical and non-graphical information and 
sharing this information in a Common Data Environment. 

• 4D: Scheduling 
It is the main characteristic for differentiate BIM from others work 

methodologies: dynamism. This methodology provides a new temporal dimension. 
Information about delivery dates, installation/construction time, the sequence in 
which components must be installed and dependencies with other project areas and 
so on can be include. For this reason, will be possible make a complete temporal 
planning of all and each phases of the project, which will vary according to the changes 
in the characteristics and conditions thereof in the different stage of execution. In 
addition, will allow generate a visual model of the infrastructure in each phase. 

• 5D: Cost 
Incorporate information about costs in the project 4D model allows more quick 

estimation in the costs of the designed elements. This dimension offers the possibility to 
analyse differents models in order to stay within the client budget. 

The principal aim of 5D is to improve the project profitability. 
 

                                                           
3 https://editeca.com/bim-en-latinoamerica/ 
 

https://editeca.com/bim-en-latinoamerica/
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• 6D: Simulation 
It is consist of simulating the possible alternatives of the project. Provides 

fundamental information, that allows better compression of the cost of assets 
throughout useful life (where the largest amount of money is spend, proportionally), to 
take the final election.  Thanks of this, will be possible to select the better techniques 
and technologies for each project, optimizing energy consumption and reducing as much 
as possible the environment damage. 

It is can include information about: the component manufacturer, the installation 
date, the energy efficiency, the required maintenance and details of how should be set 
up and operate for optimal performance with additional information about useful life 
and dismantling data.  

• 7D: Facility Management Applications 
In this stage the model is already built. The 7D BIM model take care of the 

management of infrastructure and the management of facilities and assets. 
 

 
           Figure  1.5- BIM dimensions 

 
In some countries there is already talk about 8D: Safety and Health-Prevention of 

Occupational Risk. 

1.5.4 Common Data Environment 
 

Among the most salient points of the BIM Methodology, it is including the 
possibility of integration and coordination between the different stages of the project in 
a central and unique model. The workflow of the information follows the ISO 19650 
standard (December 2018), which define a federation strategy in order to help plan the 
production of information by separate task teams to the appropriate level of information 
need. The norm specify that it is necessary work in a Common Data Environment (CDE), 
where all the documents geometrical and no-geometrical (defined as information 
containers) are collected and managed and will be available for all the teams of the 
project.  
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The revision of the information containers within the CDE should follow the next 
states: 
- Work in progress: used for information while it is being developed by its task team. 

The Information container in this state should not be visible or accessible to any 
other task team, which it is very important if the CDE is implemented through a 
shared system (shared server or web-portal). Before continuing with the next step, 
the information container should be review (by the originating task team). 

- Shared: its purpose is to enable constructive and collaborative development of the 
information model. Information containers in this state should be consulted by all 
appropriate appointed parties for coordinate with their information. If an 
information container meets the information requirements (for coordination, 
completeness and accuracy) its state is changed to published.  

- Published: this state is used for information that has been authorized for use (for 
more detailed design work, for construction or for asset management).  

 

 

                 Figure 1.6 - Common Data Environment concept - ISO 19650-1 

 

                        1.5.5 Level of information need 

 
Before the publication of the ISO 19650 (December 2018), three standards were 

available:  the Italian, the British (UK) and the American (US). Because of the new 
standard is very recent, some of their definitions are still used, such as the Level of 
Development. This concept was first introduced in 2008 when the American Institute of 
Architects (AIA), however with the passing of the years, different countries have 
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developed several LOD scale, and they use them as parameter in their policy 
requirements. 

 The Level of Development is a unit of measure which inform until what point an 
element has been develop in the model. It is a measure of the amount of information 
and the quality of it. LOD comprises both graphical representation and information 
linked to the element. Therefore, the LOD is determined by the relationship between the 
Level of Detail (it is regarding to the amount of details that are include in the model 
element) and the Lever of Information the non-graphical information to be included in 
the BIM. The level of detail can be considerate like an input of the element whiles the 
LOD it is the output. It is important to know LOD is not referred to the entire project (and 
has no connection with the construction or development phases) but to each project 
element. 

In Italy, the “Ente Italiano di Normazione” introduced the UNI 11337-4 standard 
with the purpose of introducing the quantitative and qualitative aspects of management 
of digitized information process in the field of construction. In this norm 7 LOD are 
define, from A to the G. This standard is now a national appendix of the ISO 1950. 

 

 
         Figure 1.7- Italian Scale of LOD, figure taken from UNI 11337-4 prospetto C.22 

The ISO 19650 2019 standard (Organization and digitization of information about 
buildings and civil engineering works, including building information modelling. 
Information management using building information modelling.)  is being developed to 
aid the managing of information over the whole life cycle of an asset using BIM. The 
contents of ISO 19650-1(Concepts and principles) and ISO 19650-2(Delivery phase of the 
assets) is in alignment with the BS1192 and PAS 1192-2. 

This standard has introduced a new concept: Level of Information Need: 
“framework which defines the extent and granularity of information”, which replaces the 
Level of Development (US) and the Level of Definition (UK) concepts.  

One of the objectives of this new concept is prevent the delivery of too much 
information, for this reason the definition emphasis on the fact that “the level of 
information need of each information deliverable should be determined according to its 
purpose[…] it should be determined by the minimum amount of information needed to 
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answer each relevant requirement, including information required by other appointed 
parties, and no more.” 

For its definition should be considered the quality, quantity and granularity (allude 
to the level of detail in which it split) of the information. The Level of Information Need 
is defined on each type of report extracted from the model, so can vary from deliverable 
to deliverable, for example in the case of a column the level of information need can be 
different for a detail plan of reinforcement that for a transversal section plan. 

There exist a range of metrics to define the levels of information need, and it is 
possible to use more than one to define it, but of course there must be concordance and 
once these metrics are defined, they should be used across the whole project or asset.  

Before to start with the modelling it is necessary to think with what Level of 
Information Need work, in order to avoid putting in the model unnecessary information 
and save time. This should be described clearly within the organization, project, asset or 
exchanges requirements, which describe what exactly is covered by the various stages. 
The Level of Information Need is closely linked to the federation strategy. 

                        1.5.6 Stages of Maturity 

 
Another concept that changed from the publication of the new standard ISO 

19650, it was the Level of Maturity, which refers to construction supply chain's ability to 
operate and exchange information, defined in the PAS 1192-2 standard.  In the new 
norm, was replaced by Stages of Maturity. Some principles have been combined while 
others have been simplified. 

The new classification it is represented in scheme named: A perspective on stages 
of maturity of analogue and digital information management, which replaces the scheme 
of the Level of Maturity. 

One of the countries more advanced on the level of maturity is UK, where the 
Government Construction Strategy published in 2011, stated that will require fully 
collaborative 3D BIM as minimum by 2016, which is a minimum requirement for Level 2 
BIM on centrally-procured public project. Nowadays, they are working towards BIM 
Level 3(Building lifecycle Management) for 2020. 

 
                      Figure 1.8- UK maturity model from PAS 1192-2:2013,  
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             Figure 1.9- ISO diagram from BS EN ISO 19650‑1:2019 

 
             There are three stages composed by several layers: 

The standards layer, of the stage 1 is compose by the National standards, of stage 
2 consist in the ISO 1950 and in the case of stage 3 will be supported by standards that 
not yet exists.   

The technology layer, in the stage 1 and 2 is supported on a Common Data 
Environment based on the management of information, and in the stage 3 will be provide 
a database where will be possible have direct access to all the information contained in 
the models. 

The information layer, in the stage 1 use principally structured and unstructured 
information, in the stage 2 add the federated information model concept (means 
composite information models that include information models from separate sources), 
and in the stage 3 incorporate the server use, which allows the direct management of 
the elements. This layer with the business layer, are the ones that bring greatest 
advantage in term of collaboration. 

The ISO 19650 series has application mainly at Stage 2 maturity. This is where a 
mixture of manual and automated information management processes are used to 
generate a federated information model. Nevertheless, also can be partly applied at 
Stages 1 and 3. 

Through this thesis, with the development of the chapter 5, it was intended to 
achieve a state 3 of maturity of the model, using a Server that contains the federal model, 
which has information contribute by two different members of the project. 
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                        1.5.7 BIM for Infrastructure 

 
The main difference between BIM and InfraBIM is that BIM understands the inside 

of an architectural work, what is known as MEP (Mechanical, Electrical and Hydraulic 
installation) and BIM Data that includes structural, architectural and site information. 
Whereas, the InfraBIM is applied to project which has greater horizontal development, 
thus is necessary also information about the land and its use, the geology (GIS 
Environmental Data) as well as cadastral and topographic information (GIS Base Data). 
The BIM methodology was originally created for the architectonic industry, however the 
evident benefits that brings have made other types of projects interested in its 
application. 

This is the reason why the use of BIM in infrastructure did not have the same 
growth rate compared to other constructions. 

The McGraw-Hill Construction report stated the following:  

“The level of BIM adoption and use in the infrastructure sector is a few years behind 
vertical construction, but infrastructure projects are well-suited to benefit from a model 
driven approach to design and construction, which bodes well for accelerating usage and 
broad acceptance of BIM in this sector.” 

In the lasts years, the need to optimize the infrastructure projects has made of the 
InfraBIM one of the most important developments in the sector. Many Governments 
around the world have invested in BIM research and education, with the aim of including 
it in all of the project stages. The significant benefits that have been seen have been such 
that they have made the BIM tool almost mandatory in this field. 

 
Figure 1.10- Italy InfraBIM regulation, figure taken from class slide of the course:  BIM and InfraBIM for Built heritage, 
PoliTO 
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      State of the art: 
 
               The degree of implementation of the InfraBIM has had a great increase and it is 
expected to continue growing. 

The Dodge Data & Analytics (North America’s leading provider of analytics and 
software-based workflow integration solutions for the construction industry) carry out a 
research in US, UK, France and Germany, about the uses of BIM in infrastructure, they 
take this information as a key indicator of the dynamics of BIM usage. The following 
graph gives information about how many of the engineers and contractors who are 
currently working with BIM report they were (2015), are (2017), and expect to be (2019) 
using BIM on 50% or more of their transportation infrastructure projects.  

 

     
Figure 1.11- Left: BIM for Transport Projects; right: Improvements by using BIM                    

It is noticeable that the percentage of heavy BIM users (deploying it on half or more 
of their transportation infrastructure projects) powerfully surged between 2015 and 
2017.  

The study demonstrates that there are some compelling reasons for the embrace 
of BIM in the transportation sector : the vast majority users (87%) report that they see 
positive value from their use of BIM ;  nearly two thirds believe that they are seeing a 
positive Return Of Investment from their use of BIM, with about half of those reporting 
a ROI of 25% or more ; most of the users find that using BIM improves their processes 
and project outcomes most by reducing errors, omissions and conflicts in coordination , 
and providing greater cost predictability and better understanding of the project. Also, 
in the top benefits are improved schedule performance and design optimization. 

The increase of the use of BIM for infrastructure project can be appreciated 
through the growth in the different infrastructure fields in which it can be applied, for 
instance: 62% of those doing aviation projects report that they currently use BIM on the 
majority of their projects, a much higher percentage than those doing roads (51%), 
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bridges (52%), rail/mass transit (52%) or tunnels (49%); and 69% of large contractors 
report now using BIM on most of their projects versus only 53% of smaller ones. 4 

 

                        1.5.8 Interoperability 

 
In the construction industry, when a project is carried out there are many 

disciplines that intervene in it. Architects, civil, mechanical, electronic and administrative 
engineer work together to achieve a sustainable project. For this reason, interoperability 
has a fundamental role in BIM methodology, because is it very important that the 
different sectors can share information with each other and if it is desired that the 
generated data in one phase can be used in the next, without having to be introduced 
again. It is the foundation for OpenBIM and this workflow is not possible without an 
interoperable software. 

 
Figure 1.12- Difference between exchange and interoperability 5 

The software interoperability is the capability of different programs to exchange 
data via a common set of exchange formats, to read and write the same file formats, and 
to use the same protocols.6 

One of the key points of software interoperability is customers are free to work 
with their favorite software and to change from one product to another, keeping the 
data intact after the transfer. Not only must be able to transmit information, but also 
meanings (Semantic Interoperability). 

Interoperability is one of the drawbacks of BIM implementation, nevertheless it is 
expected that over the years this in no longer a problem, the various software companies 

                                                           
4 Images and information taken from “Top Business value of BIM for infrastructure 2017”, by Dodge 

Data & analytics, Smart Market Report, 2017 
 
5 Figure taken from http://biblus.accasoftware.com 
6 http://www.newworldencyclopedia.org/entry/Interoperability 
 
 

http://www.newworldencyclopedia.org/entry/Interoperability


       InfraBIM and Interoperability: Maintenance plan implementation and BIM communication 

 

Page | 15 

such as Autodesk and Trimble are making agreements to achieve higher levels of 
interoperability.  

The information transfer (geometric and non-geometric) is done from a common 
extension, called IFC (Industry Foundation Classes). IFC is a fundamental part of the 
OpenBIM practice. It is important to say that there are also other types of common file 
format, like COBie (Construction Operations Building Information Exchange). 

In this thesis, the experience of the interoperability among the different software 
used will be described. 

              1.6 Software Selection  

The author chosen to work with many programs as possible, in order to be able to 
analyse the interoperability between them, which it was one of the purposes of this 
thesis. Also for this reason, it was decided to work with software developed by different 
companies. 

In addition, it opted to work with program that are not common or popular in the 
university environment and take the opportunity the Politecnico di Torino provides given 
software licenses.  

Four software were used: Civil3D by Autodesk, Rhinoceros with the plug-in 
Grasshopper by Robert McNeel & Associates, Tekla Structures and Novapoint, both by 
Trimble. 

A little introduction of each program was carried on in the following chapters. 
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2. METHODOLOGY 
 

 

           2.1 Organization 

In order to accomplish the goal that has been set for this thesis, achieve a 4D Model 
of the infrastructure, the work was divided in different stages. In each stage have been 
used the software that was considered better for the development of the task. In this 
way it has been possible to analyze the interoperability between them, as well as the 
advantages and disadvantages. 

Through this thesis, a BIM methodology was applied focused on a maintenance 
plan analysis and on the communication and collaboration between several users in the 
same project. 

 
Phases: 
A 4D model is based on a 3D model in which time information is included. The first 

step towards the 4D model was the context creation, in which the viaduct structures 
were located. The second step was the bridge creation, with a certain level of detail 
according to the aim of this stage. The third step was to relate the model with a 
maintenance plan.  

 

 
                                      Figure 2.1- General Approach 
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           2.2 Road Modeling 

This stage consisted in generate the terrain surface where the viaduct will be 
located.  Because of, was necessary to create the road model, since the final surface will 
depend on the general characteristic of the road. In addition, of this model it was 
obtained the feature lines of the bridge, useful for the development of the next stage: 
Bridge Modeling 

To carry out the road model, was used a software specifically orientated to civil 
engineering and topography: Civil3D. 

A.N.A.S provided the terrain information that was used as a base (DTM file) for the 
final surface, and information about the road dimension (AutoCAD plans) 

The general characteristics were defined such as: horizontal and vertical alignment, 
terrain surface and exact location. 

The result was a 3D in which the viaduct’s previously stated characteristics were 
defined. 

 
 

 
    Figure 2.2- Road-context methodology 

                         

           2.3 Bridge Modeling 

After the objectives of the first phase were obtained, the working methodology 
proceeded with the viaduct modeling through new software. Road model information 
was used as a base to locate the viaduct structure. 

In order to create the viaduct model, two software were used: Rhinoceros 6 with 
a Grasshopper plug-in and Tekla Structures. The use of these software allows to obtained 
a parametric model, which mean “the creation of a digital model based on a series of 
pre-programmed rules or algorithms known as 'parameters' ” 7; it gives the benefit of 
modifying the project without major efforts. 

                                                           
7 https://www.designingbuildings.co.uk/wiki/Parametric_modelling 

https://www.designingbuildings.co.uk/wiki/Digital
https://www.designingbuildings.co.uk/wiki/Model
https://www.designingbuildings.co.uk/wiki/Parametric_modelling
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To start use Rhinoceros was necessary import the feature line of the bridge 
corridor created in CivilCAD3D. With the plug-in Grasshopper was possible to create all 
the lines, curves and points necessary to generate the bridge element on Tekla 
Structures, from these few feature lines. 

Directly on Tekla Structure was created others bridge elements like parts of the 
guard rail, the reinforcement and the abutments.  

 
 

 
                               Figure 2.3- Developed activities to obtain the bridge model 

                    

           2.4 Maintenance plan and BIM collaboration and communication  

Once the 3D model of the bridge was created, it was possible to proceed with the 
implementation of the maintenance plan. Each element was related with the 
maintenance data (information about what are the controls, how to carry out them, and 
the frequency) and the maintenance calendar (the specific date of the controls), so this 
is the part of the thesis where time is taking into consideration. 

Firstly, the model was divided on the main parts (phases) and each one of the 
subdivisions created received two identification codes, named: Control Code and 
Element Code, which would be useful to assign the maintenance tasks.  

To carry out these activities, three software were used: Novapoint, Tekla and 
Synchro. By using Tekla, it was possible to include the time through an approximate 
maintenance schedule designed by the author, of the year following the construction of 
the bridge, and create a maintenance program simulation. Because the animation was 
not as expected the author decided to use Synchro.  

With Novapoint it was possible to relate the maintenance information with the 
corresponding item, as well as generate several representations of the control 
frequency. 

The project communication and collaboration were carried out using the 
Novapoint package, creating a new project on a common server on Quadri. In this 
project, it was possible to insert and connect the models created (with different 
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software) by different users. The communication was principally developed through the 
Topics Tool, which allowed model comments between Novapoint Base and Easy Access 
(web site). 

This final chapter gave end to the 4D BIM model methodology implementation. 
 

 
                          Figure 2.4- Developed activities by each software 

                                     

 

 
           Figure 2.5- Interchange formats between the various software for the communication of the information 
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3. ROAD MODELING 

            3.1 Software Chosen  

For the road and terrain modeling it was decided to employ Autodesk Civil 3D 2019. 
The reason behind this choice was that is a software which offers good solutions for 
design and documentation of infrastructures, besides it is compatible with BIM 
methodology. Autodesk Civil 3D tools allow a great collaboration and efficiency in the 
work flow. The innovative design tools help to reduce the time it takes to design, analyze 
and implement because it dynamically links the elements created. 

Furthermore, interoperability was a purpose of this thesis, so to analyze the 
interoperability between several software in the actual market was convenient to work 
with a software created by a company different to Trimble, which is the company which 
created Tekla Structures (one of the software have been used in the second stage). 

            3.2 Modeling Procedure 

To obtain the desired model, the software requires follow a determined 
procedure: generate the surface, create the alignment, the road section and the corridor. 
Finally, it is possible obtain the general surface. 

 

                3.2.1 Units and zone  
 

Before start with the modeling it was important to set the drawing units (meters 
and degrees) and the zone of the project, it was selected ETRS89 / UTM zone 32N as 
coordinate system and EPSG code: 25382. In this way it was georeferenced the 
information of the contours. 

This part has been very important to perform the BIM collaboration in the last 
chapter of this thesis.  

                3.2.2 Surface 
 

Surface creation was the first step in the road-context procedure. AutoCAD Civil 3D 
offers different methods to create a DEM (Digital Elevation Model), which is a 
representation of a terrain’s surface created from terrain elevation data, such as from 
break lines, combination of points and contours. 

In this work was worked with contours, which would be the base information for 
the surface creation. The information was provided by A.N.A.S, from an AutoCAD file. 

Once the AutoCAD file was opened in Civil3D, it was necessary to create the 
surface, the steps were the following: 

 
1- Create a new empty surface. 
2- Add the imported contours in the surface definition recently created. 
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Home > Surface > Create Surface > Definition > Right click on Contours > Add 
After creating the TIN surface, the representative line of the planimetric alignment 

was added in it. This line was imported from other file (“Tracciamento asse”) provided 
by A.N.A.S, using the command “Paste to Original Coordinate”. 

 

 
              Figure 3.1- Initial Surface                

On the previous imagine, it is possible to see in yellow the future road. 
Furthermore, was carried out an elevation analysis of the surface. The result was a 

colored surface, in which it is possible to see on a color scale, the different heights 
corresponding to the contour lines, and the creation of the elevation table which shows 
the minimum and maximum elevation according each color. This allows a more accurate 
and easy interpretation of the terrain.  

 

 
                           Figure 3.2- Initial surface elevations 
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The generated surface represents the terrain in which the whole road will be 
develop, therefore it is too large respect the area of interest for the case study. In order 
to not work with an unnecessary data, the total surface was cropped in a portion of 
interest, located between stations 0+000 and 1+350, the cropped surface was 
represented in the figure 3.1 by the red perimeter. 

The path followed to create the cropped surface was the followings: 
 
 Surface Selection > Surface Tools > Extract from Surface > Create Cropped Surface 
 
  A polyline was used to define the new surface limits (the red perimeter). 
Finally, a surface with smaller dimensions was created in a new file (much light), to 

work in this file had the advantage of handling less information, so the software worked 
better. 

 

 
     Figure 3.3- Cropped Surface 

                3.2.3 Alignment  
 

The second step in the roadway and site design with Civil3D was creating the 
alignment. The alignment is the route of the road, defined as a combination of lines, 
curves and spirals that are viewed like one object. 

For the creation of the horizontal alignment, the georeferenced CAD 2D polyline 
transferred in the previous step was used like centerline. 

The path was the following:  
 
Home > Create Design > Alignment > Create Alignment from Objects 
 
The software allows to apply geometric design norms and see warning signs on the 

alignment which indicate that some conditions raised by the design criteria is not being 
respected. However, this is not the case because the polyline used like centerline of the 
alignment has been design by A.N.A.S. and complied with the standard. 
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Besides, the alignment label set was modified in order to show in a clearly the 
visual information. It was decided by the author to locate major station every 25 meters 
and minor stations every 1 meter. 

 
                Figure 3.4- Horizontal Alignment 

To continue with the procedure in an accurate manner, it was important to prove 
the alignment has the correct coordinate. This it is showed in the Property as Reference 
point X and Reference point Y. 

                3.2.4 Surface Profile  
 

Before defining the vertical alignment, it was necessary to create the surface 
profile. The surface profile consisting on terrain elevations along a horizontal alignment. 

Civil3D allows created the profile in a very easy steps, this ability to recognize and 
recreate a surface profile means a great utility for the designer, because save a lot of 
time when the designer must decide the vertical profile of the road. 

The procedure consisted of the following path: 
 
                Home > Create Design > Profile > Create Surface Profile 

 
                        Figure 3.5- Surface Profile build-up             
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The cropped surface and the horizontal alignment were the inputs for the profile 
creation. Also, it was possible to configure general aspect for the profile view like station 
range, profile view height, profile display options, data bands and profile hatch options. 
Once the “Create Profile View” option was selected, the software proceeds with the 
profile creation, and a Cartesian representation (with the elevation in ordinates and 
station in abscissa) of the surface profile was obtained. 

 

 
                Figure 3.6- Surface Profile 

                3.2.5 Vertical Alignment  

 
This step corresponds to the altimetry modeling. The design profile displays the 

dimensions envisaged for a given horizontal alignment. An alignment and a profile 
represent a 3D path. 

Usually, the profile is created directly on the surface profile, the designer trying to 
equilibrate cutting and embankment volumes, as well as, respecting the maximum slope 
according to the design speed. Nevertheless, in this case the predesign was already done 
by A.N.A.S, so the information of the elevations corresponding to each station was 
extracted and wrote in a .txt file. 

The profile was built through the following path: 
 
                         Home > Create Design > Profile > Create Profile from File (requires select the 
file and the alignment to which assign the elevations) 

 

 
           Figure 3.7- Vertical alignment 
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                3.2.6 Assembly 

 
The next step in the road-context modeling was the creation of the cross sections 

for the road. This task was carried out using an Autodesk Civil 3D drawing object called 
Assembly. Assembly objects contain and manage a collection of subassemblies, such as 
travel lanes, curbs and side slopes that are used to form the basic structure of a 3D 
corridor model and it can reference one or more offsets. The subassemblies are provided 
in a set of catalogs.8 

 
The following path was using: 
      Home > Create design > Assembly > Create Assembly 
                                                       
It was decided by the author to create several assemblies with the objective to 

represent in the most exactly way the design road. 
For the road Variante di Demonte several sections were created, because, 

according to the information provide by A.N.A.S the slopes of the cut and embankment 
change along the road, as well as the presence of ditch. 

Civil3D, offers a library of subassemblies in which different types of cross section 
components, like:  shoulders, lanes, daylight, retaining walls, medians, and curbs. These 
elements can been seen in the tool palettes. 

 

                                        
                                               Figure 3.8- Assembly tool palettes                                                        

For the assembly creation the assembly offset tool was very useful, allowed to 
reduce the time spent on the assembly creation. First was created all the left side 
subassembly, then with an offset were created the right-side subassembly. 

The lane was created first; the type of lane selected was the Lane out Side Super 
with Widening, in which the different layer thicknesses could be detailed in its 

                                                           
8  https://knowledge.autodesk.com/support/civil-3d/learn-    

explore/caas/CloudHelp/cloudhelp/2019/ENU/Civil3D-UserGuide/files/GUID-B01563A3-A7FB-441D-
987A-2A2801EEC321-htm.html 

 

https://knowledge.autodesk.com/support/civil-3d/learn-%20%20%20%20explore/caas/CloudHelp/cloudhelp/2019/ENU/Civil3D-UserGuide/files/GUID-B01563A3-A7FB-441D-987A-2A2801EEC321-htm.html
https://knowledge.autodesk.com/support/civil-3d/learn-%20%20%20%20explore/caas/CloudHelp/cloudhelp/2019/ENU/Civil3D-UserGuide/files/GUID-B01563A3-A7FB-441D-987A-2A2801EEC321-htm.html
https://knowledge.autodesk.com/support/civil-3d/learn-%20%20%20%20explore/caas/CloudHelp/cloudhelp/2019/ENU/Civil3D-UserGuide/files/GUID-B01563A3-A7FB-441D-987A-2A2801EEC321-htm.html
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parameters, as well as the transversal slope. Then the shoulder was created, widths and 
depth were taken as constants, the slope parameter was the same that the lane. Another 
subassembly included was the basic curb, in which the height and width were defined. 
Finally, the DayLightBrench was included. Several parameters were defined to obtain the 
most accuracy result: Cut/Fill Slope, Maximum Cut/Fill Height, Bench Slope and Bench 
Width. Only in the left side, a Ditch subassembly was included. 

 

 
          Figure 3.9- Cross-section template                        

Thirteen cross sections were created, that used the cross section defined 
previously like base, so the sections elements are the same, just changed some 
parameters. 

A different cross section was created to represent the sections that are near to the 
bridge abutments. In order to obtain a final terrain similar to that which will be in reality, 
it was decided by the author to create a cross section with retaining walls, parameters 
like the wall top width, top height and footing cover could be detailed. 

 

 
                            Figure 3.10- Cross-section with retaining walls 

For the viaduct eight cross section were created, with the aim to represent in the 
best possible way the slopes. The representation of the bridge cross section was just for 
represent correctly the location, thus the cross section selected was not very similar to 
the cross section that really the bridge will have, and the columns were not represented.  
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                                       Figure 3.11- Bridge cross-sections     

                3.2.7 Corridor 

 
Generate the corridor was the most important step to achieve the aim of this stage 

and it was the final step in the road modeling. 
A corridor model builds on the uses various Civil3D objects and data, including 

subassemblies, assemblies, alignments, surfaces, and profiles. The corridor manages the 
data, tying various assemblies to the baselines and their finished grade profiles. 

A corridor object is created from a baseline (alignment) by placing 2D sections 
(assemblies) at incremental locations, and by creating matching slopes that reach a 
surface model at each incremental location. 

Corridors are created from and based on existing Civil3D objects, which include: 
• Alignments (horizontal). Used by a corridor as its centerline. 

• Profiles (vertical alignments). Used to define surface elevations along a 
horizontal alignment. 

• Surfaces. Used to derive alignments and profiles, and for corridor grading. 

• Assemblies. Represent a typical section of a corridor. Assemblies comprise 
one or more subassemblies connected. 

After created the corridor, it is possible to extract data from it, including surfaces, 
feature lines (as polylines, alignments, profiles, and grading feature lines), and volume 
(quantity takeoff) data. [10] 

The path followed for tis creation was: 
Home > Create Design > Corridor 

 

For its creation was necessary indicate important corridor parameters such as 
name, alignment, profile and the target surface. All the elements previously created. 
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Once the corridor was created, it was possible to see it in the TOOLSPACE-
Prospector and define the main parameters. From here, it was possible to indicate 

between which stations the corridor will be generate and which assemblies will be use.  
 

 
         Figure 3.12- Variante di Demote corridor properties 

In the station where finish the road and start the bridge, it was necessary to create 
boundaries in order to solve the discontinuities. The boundaries serve as a transition 
between one assembly and the next one. Two polylines were created (left and right side) 
joining the end of the last road assembly with the beginning of the first bridge assembly, 
then these polylines were transformed into feature lines. The feature lines were adding 
in the target mapping like “Width or Offset Targets”, corresponding to the interested 
stations.  

 
                                       Figure 3.13- Target Mapping 
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Finally, it was obtained an adequate representation of the Variante di Demonte 
road. 

 
         Figure 3.14- 3D overview of the corridor created 

 
         Figure 3.15 - Plan view of the corridor created 

Once the corridor was created, the software allows creating a surface from it. In 
this way, is obtained a better representation of the terrain changes after the construction 
of the road. 

The procedure consisted of the following steps: 
 

- In the TOOLSPACE-Prospector > right click in the corridor name > corridor properties 
- In the properties window > Surface tab > Create a corridor surface (specify code: Top, 

is add like break-line) 
- In the properties window > Boundaries tab > right click in the corridor name > Add 

automatically: Daylight. 
 

The surface was created in function of the daylight subassembly and the top of the 
road. 
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             Figure 3.16 - Corridor model  

                3.2.8 Grading 
 

With the objective of obtain a similar terrain that will be in the bridge abutments 
stations and in the stations near this zone, it was decided by the author to create a 
grading group, a dynamic grading surface was automatically created.  

To create the grading group was necessary to create the feature lines that were 
used like boundaries.  

 
Home > Feature Line > Create Feature line from corridor 

 
The top right and left edge lines of the part of the corridor with an assembly called 

“Muro” (retaining wall) were selected; the result was a feature line that outline the edge 
of the sections of interest. This process was done for the two abutments. 

   To path followed to create the grading group was:  
 

Home > Grading > Create grading group 
Home > Grading > Grading creation tools 

 
In this case, it was required to create two grading and one transition, all were the 

type: Grade to Surface, so a target surface was indicated. After creating the grading, the 
software requires select the feature line and indicate the direction, slope and the length 
of the grading. The first grading covers the farthest retain wall sections of the bridge 
abutment, and the slope indicated was the same that the daylight defined previously. 
The second grading covers the entire abutment, but in this case the slope indicated was 
0.1 in order to generate an almost straight section. To create the transition, it was 
necessary select the feature line in which will develop, also was required indicate the 
location between the two grading. 

Automatically, a surface with the name of the grading group was created. 
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                Figure 3.17- Plan view and 3D view of the first grading 

                           
                Figure 3.18- Plan view and 3D view of the second grading 

                3.2.9 General Surface 
It was necessary to create a general surface, in which all the surfaces created were 

unified. This was the last step in the context-road modeling.  
The general surface is a single surface which contained all the changes in the 

terrain after the road construction. 
For carry out this task, a new surface was created. 

Home > Surface > Create new surface 
In the new surface, the Cropped Surface (initial terrain), the corridor surface and 

the grading surface were included. The following steps were followed: 
- In the TOOLSPACE-Prospector > right click in the surface name > definition 
- In the definition panel > right click in Edit > Paste Surface 
 

 
                                            Figure 3.19- Final surface inputs 
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Each one of the previously created surfaces was pasted using this process. 
In this case, multiple lines were deleted to obtain a better terrain representation.  
Finally, the final surface that was obtained was a realistic model for the second part 

of the thesis: the bridge model. 
 

  
        Figure 3.20- Final Surface 

           3.3 Export File 

The last activity of this chapter was to export the information that will be useful to 
carry out the bridge model and the maintenance plan implementation. 

It was necessary export two files, one for the final surface representation to obtain 
a better visualization of the bridge position and the other file for the feature lines of the 
bridge edges that will be used to start modeling it. 

 The final surface was exported in a file named LandXML, this is non-proprietary file 
format which means that is a generic file type, the information is encoded using 
standardized protocols so many programs understand its contents: civil/survey 
data, such as point, lines, faces, etc. making it easier to share surfaces between 
different programs. 

The steps were the following: 

Click on the Output tab on the ribbon > Export to LandXML 

The dialog box of the exportation was opened and were specified the object that 
will be exported, in this case “The final surface” and the “Alignment Variante di 
Demonte”. 

 To export the features lines of the bridge edges was necessary download a plug-in 
called “Country Kit Civil3D” at the moment only the version for United Kingdom 
and Ireland is available for Civil3D 2019. With the tools that the plug-in provides, it 
was possible to export in a DWG format clear 3D polylines strings (exports corridor 
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features lines to 3D polylines), without the additional data that Civil3D contains 
which will not need for the modeling. 

The following path was using: 

Click on Toolbox in the TOOLSPACE > Click on the plug-in UK and Ireland Reports> 

                   >Additional tools> right click on Export for Construction > Execute 

It was necessary to specify from what corridor (Corridor Variante) the features lines 
will be exported and what features lines (EBD and ETW). 

 Finally, a new file was created and was saved with a DWG format. 
 

                      
                  Figure 3.21- Left: Export to LandXML dialog box, right: Export for construction country kit dialog box 
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           3.4 Chapter discussion 

The software complied with the stated aim of creating a road-context model, and 
by its use, it was possible: obtain a digital terrain model, that will permit a real 
interpretation of the viaduct positioning; locate the viaduct in the exact position; identify 
the bridge alignment and profile. 

Civil3D is a very complete software for civil engineers, principally for the road 
modeling. Allows to generate complex elements through an advanced user interface but 
easy to use. The automation of the time-consuming-tasks streamlines project workflows. 
Working with dynamic models enable save plenty of time, because allows finishing 
earlier the project and reducing the error risk. Also, with this kind of model it is possible 
to analyze several alternatives and choose the most convenient without spending a lot 
of time. Of course, all of these advantages mean a cost reduction. In addition, this 
software presents a high level of interoperability (many different files extensions can be 
exported and imported). 

All these benefits cannot be achieved by working in a traditional road design 
methodology, with AutoCAD 2D. 

The author previous knowledge in the road design was useful to understand how 
the software works. However, the time spends searching and learning the basics of the 
program was a big part of the total time spending in this stage. It is important to say that 
because is an Autodesk software there is a lot of information available.  
            As a disadvantage, due that it is the last Civil3D version some commands work 
slow and the program hang up when the parameters inserted are not common values.   

In conclusion, using the software the objectives were achieved without major 
problems. 

 

 
                       Figure 3.22- Civil3D Performance analysis 
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4. BRIDGE MODELING 

              4.1 Methodology  

 Due to the complexity of the bridge, to carry out its modeling it was necessary to 
use several software. This was also useful to analyse the interoperability between them, 
which is one of the purposes of this thesis. 

The modeling was divided in two main parts, on one side the creation of the 
parametric elements using the software Rhinoceros 3D and Grasshopper3D. On the 
other side, the final construction of the bridge model with Tekla Structures. 

 

 
Figure 4.1- Bridge Modeling methodology 

             4.2 Rhinoceros 3D and Grasshopper 

                      4.2.1 Software Rhinoceros 3D version 6 
 

This software of computer-aided design was created by Robert McNeel & 
Associates. Rhinoceros 3D is a software for the modeling in three dimensions, based on 
NURBS. The NURBS are mathematical representations of 3D geometry that have the 
ability of describe any shape with high pressure using a smaller amount of information 
compared to the common approximations. A nurbs curb is defined through four 
elements: grade, control points, nodes and calculation rule. 

With Rhinoceros is possible to: create, edit, analyse, animate, render and interpret 
nurbs curves, surfaces and solids, clouds of points and polygon meshes. There are no 
limits of complexity, size beyond those of the hardware. 

In short, its main function is to provide as many tools as possible for the generation 
of the digital geometry, in an intuitive way.  

The big variety of formats with whom can work, allow the user to break with the 
compatibility impediments.  
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A great progress of the last version of Rhinoceros was that Grasshopper is included. 

                      4.2.2 Import Bridge Edges lines 

 
The file DWG that contains the features lines of the bridge edges (exported with 

Country Kit Civil3D) was imported into Rhinoceros. After selecting the file, the DWG 
import options dialog box was opened, and the model units were specified. 

 

Once the file was imported, four different views of the project were showed on the 
main screen: Top, Perspective, Front and Right. 

 

 
                 Figure 4.2- Features lines imported in Rhinoceros 

        Also, clicking on the curves it was possible to know its properties (set up in 
Civil3D) like the type of the object, the layer name, etc. because of that was very easy to 
understand with element represent each curve. The green curves are the features that 
represent the bridge edges, the red curve represents the central alignment and the blue 
curves represent the features lines for the road edges, so the blue and red curves were 
deleted in order to have only useful information for the bridge modeling.  

         In addition, was possible to know the coordinate in each point of the view 
because the file also contained this information. 

                      4.2.3 Grasshopper 3D 

 
 Grasshopper is a graphical algorithm editor tightly integrated with Rhino’s 3-D 

modeling tools. Unlike RhinoScript, rhino.Python or others programming languages, 
Grasshopper requires no knowledge of programming or scripting, but still allows 
designers to build form generators from the simple to the awe-inspiring, without having 
to write codes.  
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Has become a robust development platform and it was used in some of the most 
ambitious design projects of the past decade. 

In this thesis, the selection of Grasshopper was made because of its capacity to 
generate a parametric design. 

With this extension was possible to generate a visual programming environment 
which enable have an extensive control on the relations between the objects and its 
parameters. That was very important for the design because allowed to generate quickly 
variations, without the need of build each element and set them up from the start. 

 

                   4.2.3.1 Grasshopper – Tekla live link  
Before starting with the parametric modelling, it was necessary download the plug-

in “Grasshopper – Tekla live link”. The Grasshopper-Tekla live link enables algorithmic 
modeling for Tekla Structures using Rhino/Grasshopper. The link is a set of Grasshopper 
components that can create and interact with objects live in Tekla Structures 

After installation, the components were visible on the Tekla component tab in 
Grasshopper. There was also a Tekla menu added to the Grasshopper top menu bar, with 
commands to enable or disable all Tekla components, recomputed all Tekla components, 
delete Tekla objects, etc. The components generate, modify and interact with objects 
live in Tekla Structures, are called object creating. The link used the units of the currently 
open Rhino Document for the geometrical inputs. 

 

 
       Figure 4.3- Grasshopper-Tekla live link plug-in tools bar  

To connect Tekla with Grasshopper it was necessary to open the Tekla Model 
before opening Grasshopper or inserting a component. In this, case the Bridge Model, 
that only contains the reference model (Section 4.3.1) of the final surface, was opened. 
The Tekla components, in almost all cases (except for the Tekla points), were the last 
part of the algorithms. 

Seven components of this plug-in have been used on this thesis: 
▪ Extrude Beam (creates beams between the points in the provided point list, 

so that the end point of one beam is the start point of the next one, the 
only options available is for concrete beam but this can be changed) for the 
creation of the longitudinal beams and the curbs. 

▪ Beam (creates a beam along the provided curve or line, there are two 
option: steel or concrete beam) for the cross beam “Traversi” 

▪ Beam 2Points (creates a beam using the provided start and end points, 
there are two option: steel or concrete beam) for the central beams and 
the diagonal beams “Contravienti” 

▪ Slab (creates a concrete slab outlined by the provided geometry. The 
boundary can be a point list, a simple surface, a rectangle, a circle, a polyline 
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or a general curve) for the pavement, foundation and columns headers 
materialization. 

▪ Column (creates a column along the provided line, there are two option: 
steel or concrete beam) for the creation of the pile foundation and the 
principal columns and the guard rail columns 

Tekla Points, to create the useful points to position the columns and the 
abutments.  

▪ Components, to create a component in Tekla, was used for the 
abutments  

In addition to the geometrical inputs (lines, curves, points, surfaces), for each part 
component above, the following inputs were defined: 

- Profile: The part profile as a string. It was possible used the Profile Catalog 
component to select a profile from the Tekla Profile catalog. In the case of the beams, 
four different profiles were selected:  HI2200-22-40*1000, for the longitudinal beams, 
HI1000-16-36*400 for the cross beams, L80*80*8 for the diagonal beams and HI500-14-
28*300 for the central beams. For the principal columns a D3000 profile was selected, 
for the pile foundation the profiles were: D300 and D450, and for the guardrail columns 
B_BUILT200*200*10*15. 

For the curbs, the pavement, the foundation and the columns headers the profiles 
were not taken from the Profile Catalog, they were input through a panel with 
textvalues.   
          -       Attributes: The part attributes. It was used to construct the input object. It was 
possible to define some attributes like: Name, Class (the color which will be showed on 
Tekla), Phase, Material (can be selected from the Material Catalog) and the UDA (User-
defined-attributes). 

The author decided to use insert as attribute the Name, the Class and the Material 
of each component, the other attributes were later defined on Tekla. Nevertheless, it is 
important to say that have been better to defined them on Grasshopper, because would 
have been faster and easier.   

- Position: The part position component was used to indicate what point of 
the profile elements will follow the geometry input.  
 

 
            Figure 4.4- Extrude component and its parameters for the lateral longitudinal beams 
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 Figure 4.5- Grasshopper - Tekla live link 

With a right-click on a component icon, the option Run in background was marked 
as true. This function was for used to update in the background the Tekla model while 
the Grasshopper user interface remains responsive. 

A very important feature of this live link is the fact that if the objects that are 
connected to a component are moved in the model (Tekla), with a double-click on the 
component it is possible to update the state of the object in Grasshopper. 

As the elements are created on Grasshopper, instantly appear in Tekla. 
 

                   4.2.3.2 Parametric Model  

 
Parametric is a term used to describe a dimension’s ability to change the shape of 

model geometry as soon as the dimension value is modified. 
One of the most important features of parametric modelling is that attributes that 

are interlinked automatically change their features. In other words, parametric 
modelling allows the designer to define entire classes of shapes, not just specific 
instances. Before the advent of parametric, editing the shape was not an easy task for 
designers. However, with parametric modelling, the designer need only alter one 
parameter; the other parameters get adjusted automatically. So, parametric models 
focus on the steps in creating a shape and parameterize them. 9 

The goal of this section was to create a parametric model by using generating 
components in order to achieve a significant time optimization.  

The initial input data were the 3D polylines of the bridge edges, previously 
exported on Rhinoceros 3D. From singular points and geometrical centers of the 
structure a series of algorithms were implemented, that allowed automating the process 

                                                           
9 https://www.designtechsys.com/articles/parametric-modelling 
 

https://www.designtechsys.com/articles/parametric-modelling
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as much as possible, and with the automated process was possible to delete the tedious 
repetitive tasks (and the risk of error). 

The work consisted to generate the axis through which the futures elements 
(columns, beams, slab) will be develop, so the input polylines were moved, divided, and 
copy at certain distance in order to obtain the points, planes and curves of interest, 
without the need of do it manually element by element. The complete scripts are 
available in the appendix A. 

The parametric model was divided in eight parts interrelated: 
 
1) Creation of the longitudinal lateral beams: The axis of these beams follow 

the same shape of the bridge edge, so this step consisted on move these polylines to the 
correct position according to the planes of the bridge structures provided by A.N.A.S. 
These actions were carried out using different tools like an offset curve indicating the 
distance of the offset with a number slider in which it is possible indicate the numeric 
domain and the type number, a move with a translation vector, these are simple and 
common tools, but heavily used. The resulting curves were used to position the points 
that represent the start and the end of the beams, this was done with a component 
named Evaluate Length using as input the values of the beam’s length. The outputs were 
a list of point (X, Y, Z), that were used as input geometry on the Tekla components (as 
was explained in the previous section). Also, a component to measure the length curves 
was used to verify the result.  

 

 
                 Figure 4.6- Part of the lateral longitudinal beams script 

2) Creation of the cross beams: To make these beams, the resulting curves of 
the preceding step were used as input, also a panel list with the value of the space 
between each beam. Using the same component, Evaluate Length, the points that 
described the beams were obtained. Then the right and left points were used to generate 
the lines that represent the axis of the beams. 

 
3) Creation of the central beams: These beams were created using the central 

point of the axis of each cross beam. Once the component Divide Curve (in two parts) 
was applied, three points were obtained. With the aim of created polylines from the 
center points, several tools were used (Explode tree was one of the most important). 
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Finally, this curve was Shatter into segments from which were extracted the initial and 
finale point of the beams. (Inputs of the Beam 2Points component) 

 

 
         Figure 4.7- Part of the central beam’s algorithms 

4) Creation of the diagonal beams: The ends points of some cross beams and 
the center points of others, which are related with the diagonal beams, were used to 
define the position of its axis. This was achieved by manning lists and ranges of points 
and relating them to other. Were generated three list: for the right-side points, for the 
left side points (both will be the start points of the beams) and for the center points these 
will be the end points of the beams (In Tekla, these points will be moved in the Z direction 
until the correct position on the middle of the center beam).  Then, with these points 
were created the axis lines. 

Because two profiles had to be created in the same position but with different 
orientation, it was necessary to copy these lines with a little offset and define the 
Deforming Attributes to indicate the rotation of the second beam profile. 

 
 

 
       Figure 4.8- Part of the diagonal beam's algorithm 

5) Creation of the columns, foundations and pile: The bridge is composed by six 
columns, each of them is located under a cross beam, so the midpoint of these was used 
to position the column axis.  

To generate the rectangle foundation, it was necessary to create a new plane 
aligned with the curve of the bridge, this allowed the creation of a rectangle parallel to 
the cross beam. Several tools such as: XY Plane, Vector 2P, Align Plane, Rotate axis, etc., 
were used to carried out those actions.  
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The procedure to create the axis of the pile foundation was quite difficult because 
there were many separation distances to respect. First, four lines were created 
respecting the distance to the edges, on the rectangle created previously. Then it was 
created a grid, and for in each intersection was generated a point, but not all of them 
were needed, so using the Tree Item tool it was created an algorithm that select only the 
useful points. Finally, those points were copied and moved through a Z Vector with a 
module equal to the length of the pile, then the lines of the axis were created and used 
as input of the Tekla component. 

 

 
             Figure 4.9- Part of the script to rotate the axis 

The creation of the columns headers was divided in two parts: right and left 
(because the heights are different), but because of the shape each part was also divided 
in an arc slab and a rectangle slab. For its creation, the align planes created for the 
foundations were used. Many complex but very powerful components were used, like 
Explode Tree BANG, Tree Item, Matrix among others.  

 

6) Creation of the abutment’s points: The abutments were created as Custom 
Component in Tekla, but   using Grasshopper were created the Tekla points, that will be 
used as reference to position the custom component (with the Components Catalog). 
The first and the last cross beam axis were used as input to create the points. These point 
also were used as input on the Component Tekla command. 

 

 
       Figure 4.10- 2D view of the bridge structure in Tekla 
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         Figure 4.11- 3D view of the bridge structure in Tekla 

7) Creation of the pavement + curbs: To create the pavement surface was 
necessary to define its edges (as polylines), to do this were used the two curves that 
were imported on Rhino and were created two lines that connecting the start points 
and the end points. The four edges curves were the input of the Edge Surface tool, and 
the resulting surfaces was used as parameter to the Tekla component (Slab). 

The Extrude Beam was used to generate the barrier curb, to create the axis of this 
element the external edges of the pavement slab were moved up. This component 
requires as input the points that define the beams, so the axis was divided on segments 
(many segments as beam) and the start and end points were used as input parameter. 

 

 
    Figure 4.12- Pavement algorithm 

8) Creation of the Guard rail: This procedure was divided into two parts, one 
for the lateral beams and one for the columns. The remaining elements and some details 
were created using Tekla.  

Two beams were created, for the right and left side (there are two beams by side, 
but the second one was copied using Tekla). For the axis beams it were used the axis 
created of the barrier curb, but with an offset. For the columns, the same curve was used, 
but was divided in many parts as columns to be generated. Then the points that were 
earned were copied and moved some distance corresponding to the height of the 
columns. Finally, lines were created using those points and the Column Tekla Component 
could be used. 
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      Figure 4.13- 3D view of the Guard rail and Curb in Tekla 

As the algorithms developed, the parametric model was being displayed on the 
Rhinoceros Screen, which allowed the user to identify errors and to think how to 
continue the algorithm from what had already been created. 

 

 
       Figure 4.14- Parametric model visualization on Rhinoceros screen 

             4.3 Software Tekla Structures 2018i 

Tekla Structures is a computer-aided design and fabrication program, which works 
in 3D for the design, cutting, detailing, manufacturing and assembly of all types of 
construction structures. It was developed by Trimble Company. 

Tekla does not draw lines, but directly parametric solids within a single 3D model. 
With this software it is possible to modeling the profile and general details direct and 
quickly, using the predefine components, also include several Catalogs, from which is 
possible to select different materials, profiles and so on. 
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Once the structure is modeled, the program allows generating all kind of planes 
and material/elements list. The information showed on this planes and list is constantly 
related with the model, thus to any changes the information is updated. 

It is possible to exchange data with a high number of applications used for 
architectural and engineering works, achieving to coordinate the different areas of 
design. 

One of the most important features of this program is the fact that contains several 
tools for the calculation and structural analysis. However, those tools were not used for 
the development of the thesis. 

The author decided to work with the last version available on the market at that 
time (Tekla Structures 2018i) in order to use the new resources but also because since 
the 2018 release, the software added the live link to the algorithmic modeling tool 
Grasshopper. 

 
                  4.3.1 Reference Model  

 
The first thing it did on Tekla was insert a reference model of the final surface 

created using Civil3D. A reference model is a file that helps the user to build a Tekla 
Structures model and it can be used to overlay different models into one model. 

       The file with. LandXML format that contains the surface was imported. Tekla 
recognize the layer of the elements imported and allows hide/show them. 

 
Click on Reference Models button in the side pane> Add Model > Browse File 

(there are many compatible formats) 
 

The reference model appears together with the model, but it is not modified by 
Tekla, so it has not been useful for projecting elements but as visual guide. The user can 
snap to reference model points.  

The software loaded the reference model from the file each time the project was 
opened and each time the model was saved, the reference model did not save but it was 
saved the link to it. 

The model was named: Bridge Model and was the model opened before starting 
with Grasshopper. 

                  4.3.2 Customs Components 

 
Although most of the model was created using Grasshopper, some elements that 

contains plenty of details were created using Tekla Structures. 
For the abutments two Custom Component were created, as customized part. 
These custom components were used in the same way as the predefined 

components.  
Before creating these components, the abutments were created in a new Model. 
Reference DWG Files of the abutment’s sections were inserted and used as guide 

to generate each element of the object. As the files were inserted, new views were 
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created (from two points) to make a 3D model out of the 2D dwg-files. Each time a 
section drawing was inserted, it was moved to another plane (the corresponding view of 
this section). 

 

 
          Figure 4.15- Reference model for the abutment’s construction 

Once the DWG files were inserted, it was necessary to adjust the Grid to better suit 
the needs of the design. To a better interpretation the title, texts and quote were hidden.  

Using concrete tools such as Slab, Panel and Columns the parts that compose the 
abutment were created. Because of the shape of some of the elements two very useful 
tools were used: Cross section by sketching with variable cross section, and polygon cut. 
The profile of the lateral panels was created using the sketch editor: first it was necessary 
to outline the profile approximately as wanted, then were added the measurements to 
adjust it to the right size. All the dimensions, except for the final height, are fixed (as the 
height at the top part varies, the base needs to be at the bottom).  This variable 
measurement was configured in the next step using the variable cross section command. 
To create this kind of section, it must be first created a baseline profile based on the one 
earlier created cross section.  

Finally, when creating the panel (following as guide the line of the dwg file) the 
variable section created was selected as panel profile, and in the dialog box was possible 
to change two parameters: Start Total Height and End Total Height. These parameters 
were created when the variable profile was defined. 

Using the polygon cut command it was possible to generate the section of the other 
elements from very simple shapes. This tool consists in cut an object by picking a 
polygonal shape on it.  

On this way, accurate models of the abutments were created.  
To create the custom components: 

Click on Application and Components > Define Custom Component 
The custom component wizard was opened and the type (Part) and the name of 

the future custom component were defined. Then the software required selecting all the 
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elements that will compose the component. The last step was to select two points that 
will be used to position the part (this point was the same point created using 
Grasshopper).  

Once the procedure is completed, the custom component was available on the 
section Part of the component list and in the Component Catalog on Grasshopper. 

To add the custom component into other model, in this case in the Bridge Model, 
was necessary to publish them: 

Right click on the custom component created > Publish 
The component is saved as .uel file, then this file must to be imported on the model 

in which will be used. (Import Custom Component).  
 

 
     Figure 4.16- Abutment views 

                  4.3.3 Rebar  

 
In Tekla Structures, there are available different methods to create reinforcement. 

Generally, it must be used a combination of several reinforcement tools to get the 
wanted results. The software enables reinforcement modeling in 3D, achieving 
construction-ready level of accuracy. 

The goal of this section, introducing structural reinforcement at least in some 
structures, was to evaluate the performance of the Rebar tool that the software offers. 
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The information regarding the reinforcement was not provides by A.N.A.S, due to 
this, the author introduced structural reinforcement in one abutment and in one column, 
taking into consideration a similar project. 

In order to test different possibilities to insert the rebar, several methods were 
used according to the shape of the elements.  

For the column reinforcement, it was used a Round Column Reinforcement (82) 
detailing component. With just a click on the column the reinforcement was inserted, 
then was possible to modify some properties like numbers of bars, size, spacing and 
other stirrups attributes, so in a very quickly way was possible to define a detailed 
reinforcement.  

 
                                                                            Figure 4.17- Column Reinforcement                   

For the abutment the procedure was quite different, for convenience different 
methods were applied for each element. For the parts that are simple rectangles a 
normal rebar group was used. For the part with variable profile or complex profile, were 
used rebar sets, in some case the option Rebar shape placing tool was selected and in 
another case the Create crossing rebar tool was selected, the different between these 
options is that in the first a predefine shape was used and in the second the user create 
the shape of the rebar, which is very useful in the case of very strange profiles. For the 
elements with a variable height was used the tapered rebar group, with this tool the 
shape of the rebar was adjusted to that height variation. Therefore, reinforcing 
nonstandard geometries is efficient and flexible, because the reinforcement 
automatically understands the concrete shape where it belongs to. 

In all cases, no matter the technique chosen, was necessary to indicate the part to 
reinforce, the plane and the direction of the reinforcement. Other properties such as 
type of bar, size, spacing, distance to de edges, anchors can be defined on the Property 
dialog box. Some of these details are displayed in the appendix B. 
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With the Clash Check command, was possible to detect and locate the bars 
collisions, which was quite useful in the case of the abutment reinforcement due to the 
big quantities of rebar created.  

 

 
                                 Figure 4.18- Abutment reinforcement 

             4.4 Final Result 

The result obtained, after applied all the task that had been explained in this 
chapter, was a complete 3D model of the Perdioni Bridge. This model can be used to 
carry out many analyses such as time construction, structural analyses (after to put the 
load and define the support conditions), or cost estimation. Also, it can be associated 
with plenty types of information.  These actions can be carrying out using Tekla or 
another compatible software. Of course, more information is added better will be the 
model interpretation and there will be more benefits of the use of this methodology.   

In this case, the model will be used to link it with the maintenance plan.  

 
                         Figure 4.19-3D view of the Perdioni Bridge 
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Figure 4.20- Geometric passages 

             4.5 Export IFC 

          The final activity of this chapter has been exporting in a correct way the model 
created, which it was used for the last part of this thesis. The author decided to work 
with this type of file, because is one of the most popular formats that allows the 
interoperability with plenty of software, thanks to the standardized information. The IFC 
file, act as link of union to exchange information, regardless the software which it come 
from and to which it is directed. 

Tekla Structures offers the possibility to export the model on the basis of the export 
settings defined by the users. With the creation of a Property Set configuration the user 
can indicate which attributes of each entity type (IfcColumn, IfcWall, IfcMember, etc.) 
export. The principal advantage of this tool is aside from the basic attributes (Name, 
Profile, Material, Phase and so on) the user-defined-attributes can be selected. 

For this part of the thesis, it was using a predefined property set for Export type 
Coordination view 2.0 (type recommended, when the geometry needs to be edited and 
modified in the receiving software). Another important aspect to export correctly the 
model, was indicate the relative location for the export. In this case, the option base 
point was selected, because the model origin was far from the beginning of the bridge. 
The base points allow to use another coordinate system needed for interoperability and 
collaboration. The base point created was the corresponding to the start of the 
alignment (imported as reference model), it was necessary to indicate the North and Est 
Coordinate, the Latitude and Longitude, as well as select the point on the model that 
represent this base point. (The information was completed with the same information 
used in Civil3D to position the alignment) 
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             4.6 Chapter discussion 

 
 
Regarding Grasshopper, it is possible to say that is a very intuitive program that 

uses the drawing software not as representation tool but as design media, this allowed 
start creating the algorithms practically while the software was being studied. However, 
due to the author had no knowledge of this software, a lot of time was spent learning 
the different commands available, principally because there is not many free information 
of the use of Grasshopper.  

Even so, the time saved (thanks this software) in Tekla is much bigger than the time 
spent making the algorithms, because otherwise it would have been necessary to create 
element by element and thus a large number of grids (due to the bridge shape).   

In respect of Tekla Structures, thanks to the huge list of elements available on the 
catalogs (Profiles, Materials, Rebar) and on the predefined components, just the 
abutments and some guard rail details (because there are not on the component list) 
had to be created by the author, so a little fraction of the total time spent modeling was 
devoted to the element’s creation. 

The rebar tool exceeded the author expectations. It was possible to create detailed 
reinforcement with a few clicks, using intelligent and parametric components. Very 
specific details were defined as how to bend the bars and the anchorage dimensions.  

As negative aspect, the final representation did not achieve the author 
expectations. It was not possible add the road marks or visualize the material textures. 
In addition, the user defined parameters cannot be created directly on the model, it is 
necessary to create a file .inp (input) that contains the attributes and save it in the model 
folder, which represent a problem if the user does not the required writing format. It 
should be clarified that exist a way to generate these parameters directly on the model 
but they will not be displayed on the elements property window. In fact, this procedure 
was followed in the next chapter to create the zone code for the maintenance plan 
implementation. 

The interoperability between Rhinoceros and Civil3D was optimal and did not 
present problems, because Rhino was originally created as a plug-in for AutoCAD which 
is a software also developed by Autodesk. There is a big list of the kind of file that rhino 
can support.  

Respect the interoperability between Tekla and AutoCAD/Civil3D was quite good. 
The imported of the final surface from Civil3D to Tekla was done without major problem, 
but it must be highlighted that the corridor modeled, could not be represented. 
Nevertheless, this did not mean a problem because it was not necessary to develop the 
purpose of the chapter.  

With Grasshopper-Tekla live link, was possible to combine the 
Rhinoceros+Grasshopper+Tekla potential, with this plug-in the interoperability achieved 
was excellent. The greater challenge (without considering learning to use the software) 
was to find how to place the parametric model created with Grasshopper in the correct 



4. BRIDGE MODELING 

60 | Page 

place on the Tekla Model, this was achieved exported the initial curves from Civil3D to 
Rhinoceros using the Country Kit plug-in.  

 
 

 
Figure 4.21- Grasshopper + Tekla Performance analysis 
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5. MAINTENANCE PLAN - BIM COMMUNICATION 

          5.1 Software chosen 

The activities developed on this part of the thesis take place in the environment of 
the CDE and their working areas (Work in progress, Shared, Published, Archive), 
particularly in the Shared and Published setting.  At this point arise the need to find a tool 
able to connect the different professionals that inevitably use various software, 
therefore diverse exchange formats. 

To carry out this last stage, the author worked with a Trimble software: Novapoint 
(21 version). This software is relatively new, consequently it not popular in the university 
environment, that it was the reason for chose it, in order to analyze and define the 
advantage and disadvantage.   

Trimble Novapoint is a design toolset for infrastructure BIM projects, allowing civil 
engineers to effectively design all aspects of modern roads, railways, tunnels, bridges, 
water and sewer. With Novapoint it is possible build a complex model of the 
infrastructure most efficiently – including 3D terrain surfaces, 3D sub-surface layers, and 
3D structures such as buildings, bridges, road signs, cables, vegetation, etc. Intuitive and 
highly effective functionality makes it possible to view the model in plan, sections and 
3D.  Novapoint is integrated with the BIM server and collaboration platform: Trimble 
Quadri  in an easy-to-use way. Together they comprise the industry's most 
comprehensive BIM solution for infrastructure design. 10 

Novapoint is based on three elements task, features and tools. The tasks are the 
building blocks for the processes that are performed by different members of the 
projects, through them the Quadri Model remembers all the input and tool parameters, 
and thus the knowledge of what features was produced from the task. The Quadri model 
knows who did it and when it was done.  The features are the real-world objects, describing 
the physical environment and any other phenomena of interest for our domain; the tools 
performing the task (process) by using the features as input and produced features as 
output. 

It can be considered that the software is composed by three parts: 

Novapoint BASE: 

Trimble Novapoint Base serves as a common tool independently of discipline, 
handling the central Quadri model, it is possible to work locally (single-user) or using 
Quadri in a private cloud, collaborating with others. In addition, licenses, module loading, 
and common settings are managed from Novapoint Base. 

 
 

                                                           
10 http://resourcecenter.novapoint.com/ 

https://www.novapoint.com/products/quadri
https://www.novapoint.com/products/quadri
http://resourcecenter.novapoint.com/
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QUADRI-BIM Server: 

The Quadri model supports a large range of different import formats, including 
LandXML and DWG. It will contain all the models that there are in the Novapoint 
ecosystem. Trimble Quadri is the key to achieving BIM Maturity Level 3, including 
support for open formats like GML and IFC.  

 

• Cloud-based server 
- Storage on a public or private cloud 
- Can be stored multi projects and models 

• A central model 
- Multi-user system 
- All project members check out the central model to desktop as a local copy of 

shared model (reserve task to create, edit and calculate; release task) 
- Sharing / receiving task and objects 
 

EASY ACCESS:  

This part allows work across all kind of devices (pc, tablet or phone) and following 
all the activities on the project.  It is possible to see an overview of the Quadri projects. 

Get real-time information:  Mean get a real-time insight in the task model of Quadri 
project. It can be browsed through it and see how the task are structured and when they 
were last executed, also it is possible to follow all the changes happening in the project 
and see who’s done what instantly. 

             - Timeline:  Changes  
                    - Task:  Process structure 
           - View 3D presentations:  It is possible publish a 3D presentation from 

Novapoint directly to the project on Quadri Easy Access. 
                    - Published 3D models 
 
Novapoint and Quadri are tools that allow achieving the model federation and the 

collaboration between the different fields.  
 

          5.2 Methodology 

The objective proposed for this stage was to achieve a 4D BIM model, in which 
could be implemented the maintenance plan, and in which could be work collaboratively 
with other users.  

Before to start with the maintenance program implementation it was necessary to 
create the model that would contain the project of each user (thesis students). It was 
applied a server base solution. 

Once this was done it was possible to download the workset which would contain 
the information that would be shared. The workset was organized in tasks that define 
the structure of the process, each of them contains imported information as well as 
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information created through the imported file. To achieve an accurate import, it was 
important to dedicate time to the conversion rules, the amount of data imported 
depended on them, as well as the visualization of the new parameters created. 

The handling of 4D model is not a strong point of Novapoint, the maintenance plan 
was implemented and managed by using some commands such as Classification, 
Attachment and Presentations.  Conversely, the communication it is one of its strong 
points (by also using Easy Access, a cloud base solution), so the author decided to use it 
in a related way with the maintenance controls. 

To achieve a most accurate and detailed implementation of the maintenance plan, 
it was decided to work with the tools that Tekla Structures offers: Task Manage and 
Project Status Visualization. 

 
 

 
       Figure 5.1- Methodology to 4D management and BIM communication 

 
Server Project Quadri 
 

A Quadri project enables multiple users to work with the same Quadri model, 
hosted on a server with a unique IP and Port. 

Each Quadri server can contain of multiple Quadri models. Each model can contain 
a hierarchy of Quadri projects where each project has a unique ID which is used to 
connect to Novapoint Base. 
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          Figure 5.2- Quadri Organization 

 CRS (contains two different elements - the datum and the coordinate system) is 
attached to a Quadri model, so all projects has the same CRS. This step is very important 
to achieve the coordination of the project parts. 

It is recommended to create a new Quadri model for each project. 
The users work towards a Quadri project by checking out a workset (local copy) of 

the model. They work locally on their copy of the model and can receive / share from the 
project server. In addition, they can extract multiple worksets from the same Quadri 
project. 11 

                   5.2.1 Create a project 

 
The model was set up in the administrate program:  Quadri Model Manager 

(QMM). In this case the model had one administrator (HERPACEAS, who provide the 
license of the software) and several users (two thesis students, two thesis co-directors 
and the administrator). This was set up in QMM. 

The administrator created the Trimble Quadri Connection called:  Server Tesi, and 
in this server he associated a model named: Variante di Demonte. It was necessary 
indicating the location of the model and the members that can participate. 

Then, the following procedure was followed to create a Quadri project: 
 
Open Novapoint Base > Manage Projects > Click the + next to the “Server Tesi”(it 

is necessary to be sing in) > Variante di Demonte (Model, there is where the project will 
be saved) > Create a New Project 

 
The next step was complete with the name and description of the project, location 

and users. 

                                                           
11 Novapoint base course manual 
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                   Figure 5.3- Quadri Project Manager 

                   5.2.2 Download a workset 

Download a workset, was only possible once the user had access to the server 
project (Quadri) by a got username and password.  

The path was the following: 
Open Novapoint Base > click Join a Project 

  
In the dialog box opened, the users found the list the servers they can work with, 

in this case Server Tesi was the only showed. When the user clicks on the server, it was 
asked to log in with the Trimble ID. Then, the model Variante di Demonte was showed, 
click on the model was possible to saw the project under this model. When the user clicks 
on the project name, in the dialog box, the area of interest for the project on the map 
was showed, as well as the properties and coordinate system below the map. 

 

 
                                          Figure 5.4- Quadri Project properties 
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In addition, when the user clicks on the project name the dialog for downloading 
the workset was open: 

Select Create New Workset > Ok > Download 
The workset created was saved in the current binder (file uses as link to Quadri 

Model) of the model. 

                   5.2.3 Task 

 
To create the tasks, in which the project will be organized, it was necessary to insert 

a predefined process structure (built up from a hierarchy of summary task). In this case 
a Basic Template was selected, it was possible to rename, delete and add summary tasks. 

With the aim of obtain a better organization of the project, the author decided to 
create the following summary tasks: 

Inside the IMPORT task, three summary tasks were created, taking account the files 
that will be imported, named: /FROM DWG; /FROM LandXML; /FROM IFC. 

In order to have a task that contains all the maintenance files attached to the 
elements, it was created a summary task named: MAINTENANCE FILE. 

Also, it was created a summary task called: CLASSIFICATIONS, which will be used 
to accommodate thec Control Frequency classification and the Elements classification.  

Inside the REPRESENTATION task, two summary tasks were created:  P00 VI01 ARC 
and P00 VI01 MAN, each one of them will contain the 3D representations and the Plan 
Presentation related. The name follows the A.N.A.S standard, which will be showed in 
the section 5.5.3.1. 

Finally, it was created a task named: TABLE, which contains all the tables created. 
All the tasks are showed in the explorer  

 
                                             Figure 5.5- Tasks Explorer 
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               By hovering the mouse over a task, it is possible to see if the task is reserved, and 
by which user, and which user lastly made changes to the task. 

The task can be shared and received (this will be better explained in the section 
5.7). Also, it is possible to reserve or release the entire or parts of the workset. 

The status icons in the Explorer pane are reporting the status between the workset 
and the centrally shared Quadri model: 

- Grey line: Read only in the workset. The task is not reserved by another user. 
- Grey line with a lock: Read only in the workset. The task is reserved by another 

user. 
- Green line: Task reserved by you, and can be edited in this workset 
- Blue line with an exclamation mark: Task reserved by you which is changed in 

your workset, but not shared to the server. 
                - Green plus: A new task created by you, but not shared to the server 
                

                 Reserve 
With this function it was possible to reserve a task with the aim of update it (edit, 

delete or do other operations). The selected task and the resulting features are locked 
for other users, until they are released.  

 
Right click on the task > Click Reserve 

 

              Release 
After shared the changes of the tasks and when the user “done” working on them, 

it was possible to release the tasks, in this way others user could reserve them if needed. 
 

Right click on the reserved task > Click Release 
 

These tools allowed working in order and reduced the risk of the collaboration 
mistakes. If someone wants to reserve a task that it is already reserve by other user, the 
software sends a message ask him if desire allows this operation.  

These actions make the software’s potential, because allow not only to visualize 
the part of the project added by other users, but also modify it or add elements, by using 
just one software.  

 

         5.3 Import file  

To start working with this software it was necessary import all the file related with 
the project, DWG and LandXML files for the terrain and IFC file for the bridge model 
made in Tekla Structures.  

http://help.novapoint.com/doku.php?id=en:np:base:reference:explorer:statuses_when_shared_model
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Figure 5.6- Flow of information for project coordination 

       5.3.1 Civil 3D Connector 
 

The Civil 3D Connector is an extension on top of Novapoint Base that allows the 
import of native Civil 3D objects into a Quadri DCM model. Using this toolkit, the Civil3D 
design data can dynamically get imported into Novapoint Base and reused there for 
further design or analysis.12 

Workflorw  

When the user opens Novapoint, automatically Autodesk Civil3D opens. The first 
step was to create a CivilConnector Task in Novapoint Base.  At this point was possible 
named the connection and assigned the appropriated subtask. In this case, the author 
decided to name the connection “Civil3D Connector 2” and the subtask /10 IMPORT /102 
FROM DWG . 

 
        Figure 5.7- Civil Connector ribbon 

The second step was opened the context-road model in Civil3D and                             
click in the “Novapoint” tab > Import. The program required to indicate the task which 
the user decided connect to. The option “Launch conversion rule editor” was marked, in 
order to could decide the conversion rules for the feature in Novapoint.  

                                                           
12 http://resourcecenter.novapoint.com/ 
 

http://resourcecenter.novapoint.com/
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The native objects that the author imported were: Alignment, Profile, Corridor 
Information (feature lines) and Grading. The next step was going back to Novapoint and 
edited the conversion rules, were matched the Civil 3D geometry to Quadri DCM 
FeatureTypes. 

 
    Figure 5.8- Conversion Rule Editor 

Finally, for a 3D representation of the information imported was necessary in the 
Novapoint explorer: 

Click in the task /10 IMPORT /102 FROM DWG > Right click in Civil3D Connector 2> View 
in 3D 

 
           Figure 5.9- Result of the Civil3D Connector 

The fact corridor has been imported as features lines and not as element, is a 
negative aspect, because there is many information that was lost such as thickness and 
material, and the final visualization was not very clear. To obtain a better representation 
of the corridor, it was created a Road between the station 0+0350 and 1+350 using the 
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alignment imported. It was possible to define the surface layers thickness and its 
materials. 

       5.3.2 Land XML 
 

Another way to import the terrain surface and the alignment was through a 
LandXML file.  Previously, this information was exported from Civil3D into a LandXML 
format.  

To import the file into Novapoint, was necessary to follow the following path: 
Insert > Import file 

The program required to define the name of the import and the parent task. Then, 
Input > Select file 

When the file was selected, the coordinate information was defined. In this case, 
it was chosen the option “File CRS is the same as in active Quadri Model”. Then, the 
follow window was opened, and the information was verified so it was possible to 
continue. 

 

 
            Figure 5.10- Definition of the Coordinate Reference System 

            The next step was to select the conversion rule and finish the process. 

As a result, the terrain and the alignment were represented. If the user selects 
some element, for example the alignment all its proprieties can be seen.  

 

 
                                                                 Figure 5.11- Alignment properties window  
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                5.3.3 IFC 
 

The author decided to use IFC 2X3 file to import the bridge model from Tekla 
Structures. The process followed was the same for the LandXML file, but in this case the 
conversion rule editor demanded more time because there were many elements to 
represent. Once the conversion rule for the import was created, it was possible to see 
the preview of the converted feature. 

 

 
           Figure 5.12- 3D view of the bridge model IFC file 

         5.4 Conversion rule 
 

The conversion rule editor is a very powerful tool to define how the user wishes to 
convert the source geometry into intelligent features. The creation or selection of the 
rules is necessary to achieve the importation. The conversion rules are important for 
getting as much information into the model as possible. 

In this section, the author will explain with details how created de conversion rule 
for the IFC Bridge Model file: 

Select the import file > Select rules 
 

 
        Figure 5.13- Select rules button 

 There are standards conversion rules for this kind of file, but the author decided 
to create a new conversion rule to achieve a better and specific representation. Before 
start to configure the rules, the program required some conversion file information like: 
Name, Source Compatibility, Destination Feature Catalog and the Destination 
Compatibility.  Once this information was completed, the Manning Conversion Rules 
dialog was opened. 
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            Figure 5.14- Conversion Rule created 

When the user selects New Rule a row is added, and was possible to complete the 
columns:  

Source Feature: defines the Geometry Type of the source data. The option 
IfcObject was selected. 

Source Attribute: is used for filtering the source data. There were several options 
for this task, the author decided to use Namevaluepartlist and Objecttype. For the option 
namevaluepartlist it was also necessary to complete the Conversion Key Name. In all the 
case, the author decided to use “Name” like conversion Key, in this way the software 
select the information in function of this parameter.  

Conversion Key Value: In this column the user need put the value in which the filter 
will be based. It was possible to write the value or select it from a list of the objects that 
are available in the model, based on the geometrytype set in the Source Feature value. 
In the case of the Objecttype attribute it must be completed with the IfcValue, for 
example: IfcWall, IfcColumn. For the namevaluepartlist, the column was completed with 
the name of the element assigned in the bridge model (in Tekla Structures). An useful 
option to save time in the case of elements whose names start the same and require the 
same representation, was wrote the conversion key value using the configuration /.*Part 
of the name in common*./, so all the element with this value were filtered and converted 
with the same rule, for instance this was used for “TRAVE” because this name was 
repeated for: Trave Centrale, Trave Long. Dx and Trave Long. Sx. 

Destination Feature: defines the Feature Type to create on the Novapoint side. A 
list of the Feature Catalogue in Novapoint was opened, and the feature of the list that fit 
best in each case was selected. 

 



       InfraBIM and Interoperability: Maintenance plan implementation and BIM communication 

 

Page | 75 

To show and define more specific parameters, the following path was followed: In 
the same dialog box click in View and select Attributes Conversion per Feature. 

A new section of the dialog box was opened, and it was defined what information 
of the model show and what information adds for each element. In this step, the author 
decided to show: Name, Material construction, Description, Instance Identifier and 
Texture (this was useful for the creation of the drawing rules). For define the texture 
value, was possible use the value mapping, with this tool the user can assign the 
destination for the source and automatically the software will analyze the situation and 
assign the correct value. In the case of the texture, the user can select the destination 
value from the texture catalog that is available in the PC Novapoint Folder. 

In addition, the author decided to add information to the elements that would be 
useful for the implementation of the maintenance plan, like Control Code and Element 
Code (the mean of these codes will be explain in the following section). For this attribute 
conversion name key, was necessary write the default value. Also, was possible to add 
an information list and a link list to associate to the element. 

When the attributes were defined, click Ok and went back to the Conversion rule 
dialog. The conversion rule that was made was located under Custom Conversion Rule. 
Finally, the rule was selected and was clicked Ok to finish the dialog. 

 

 
          Figure 5.15- Attributes Conversion per Feature  

Once the rule was selected, it was possible to obtain a Preview of the project. In 
the last part of the explorer, could be seen the information of the converted feature.  
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                                                             Figure 5.16- Converted Features 

 
        Figure 5.17- Bridge Model after applied the conversion rule 
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         5.5 4D Management 

                  5.5.1 Classifications  
 

With the lastest version of Novapoint, it is possible to use the Classification 
component.  This component allows insert tasks for a given classification, with the 
purpose of connect object and processes in the model that maintains various 
considerations and purposes, for example by phase division, drawing key and so on. 

The individual class assignments in a classification can be linked to objects in the 
model. This is a very useful aspect because allows to link objects belonging to one field 
and the person or company responsible for this field and connect information in the 
model with different subclassifications depending on the objective of the classification.  

The follow path was followed:  
                    Insert > Classification > Classification  
 
The name for the classification and the related summary and sub task was asked. 

The author decided to insert the classification structure from a .txt file, so in   Template> 
Import from text file. The file must be containing two columns, one for the name of the 
class code and the second one for the class description (this last can be avoid).   

 

 
                                Figure 5.18- Text file imported for classification 

Once all this information was completed, was possible finish the Classification and 
the result appeared in the Explorer.  If the user clicks in one class, the class tools open 
and it is possible to select the feature that will contain this class.  There are two Query 
methods for the selection: Dynamic Query or Select objects, and its chose will be 
depending of each case of classification.  When the elements for each class are assigned, 
it is possible to create a view of them. 

 
In this thesis, two classifications were carried out. One in which the elements were 

grouped according the frequency of the maintenance control in order to show all the 
elements with the same frequency of control, at the same time. The other for represent 
each principal element separated, which will be useful for example to reserve the tasks 
to the manufacturing company of each element.   
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                     Figure 5.19- Classifications displayed on the Explorer 

For the selection of the features, the Dynamic Query method with the task Feature 
was used. It was possible to create global attribute filters in order to select the 
information in a faster way. The filter can be created in function of the feature name or 
attribute type.  

 
                            Figure 5.20- Dynamic Query by Features, filter example  

The features for the Elements classification were selected first, because then the 
class codes of this classification were used to select the feature for the Control Frequency 
classification:  

Click in the class code > Class code Tool > Select Feature > Task > Select the class 
codes of the element classification that composes this class code > Finish 

                  5.5.2 Attachment   
 

This tool allows selecting files and links to attach and the feature they should be 
attached to. It is possible to attach more than one file or link. 

The author decided to use this tool with the aim of associate the elements with a 
file that contain the information of the Maintenance Plan of the bridge and with a link 
that allows other users to modify or add information to the file through Easy Access, in 
order to create a way to interact between all the members of the project.  
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      5.5.2.1 Create the bridge Maintenance Plan file 
 

There was no information of the bridge maintenance plan for this specific project. 
However, documentation of another bridge (S.S. 131 di “Carlo Felice”) was used as basis 
for the creation of the new maintenance plan. This documentation contained detailed 
information about the deadlines and activities corresponding to the maintenance plan. 

The structure of the maintenance plan is composed by three parts: 
 
- The Use Manual:  provides a set of information that allows the user to know 

the function and management of the asset, to avoid its early degradation. From this 
section was extracted the elements code added like attribute in the conversion rules. 

- The Maintenance Manual: provides the necessary indications for the correct 
maintenance of the bridge, identifying them punctually for the different parts and 
components and according to the characteristic of the constituent materials. From this 
section was extracted the controls code added like attribute in the conversion rules. 

- The Maintenance Program:  defines the temporally controls and 

interventions system to be carried out at fixed time, to correctly manage and maintain 
over the years the functional and quality characteristics of the works and their parts. It 
is composed by three subprograms: 

1- Performance subprogram: defines at a programmatic level the state of use, 
conservation and performance of the various parts of the asset during its life cycle  

2- Controls subprogram: defines the checks and controls program, with the aim 
of detect the status of the works at various times in the life of the elements, identifying 
the details and the dynamics of the performance falls. 

3- Maintenance Intervention subprogram: defines the time schedule and the 
order of the various maintenance interventions, to be carried out for a correct 
conservation of the asset. 

 
This information was recorded in several excel files, one for each element 

(columns, beams, abutments, guard rail, pavement). Each file is composed by three 
sheets, one in which there are specific information for the selected element, the second 
one contains the information regarding the maintenance program and the other with 
the maintenance control planned dates and have space to do comments and to indicate 
if the control was executed or no, which allows monitoring the state of the controls. The 
complete file is included in the appendix C. 

 
        Figure 5.21- Sheet 2: Maintenance Program 
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      5.5.2.2 Attach file and link  
 

The steps followed to attach the file were very similar to the process followed for 
all the imports. 

Insert > Attachments > Indicate the name of the attachments and the subtask 
related > Select features 

In this case, to select the feature the classification task was used. The next step was 
to select the file to attach. 

There is available the options to attach a link. This was very useful to achieve the 
objective of this stage, because the file attached cannot be open or download in Easy 
Access. The solution raised by the author was to create a Google Drive folder that 
contains all the files attached, and join each element to the corresponding file link, in 
through Easy Access different users can read and/or modify the information (this will be 
explain better in the 5.6.1.1 section). 

 

 
        Figure 5.22- Attachment ribbon 

 
                                                                   Figure 5.23- Example of attachments visualization of a column 

5.5.3 Presentations 
 

The software allows selecting multiple tasks or objects to display at the same time. 
To obtain a permanent views or presentations, it was necessary to create a Plan 
Presentation and/or a 3D Presentation. These presentations can be linked to orthophoto 
or WMS, but it was not the case. 

The presentations can be published to Easy Access. 
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             5.5.3.1 Plan Presentation 

 
This type of presentation (2D) also can be used to draw to AutoCAD. To generate 

the plan presentation:   
View > Plan Presentation 

 
Once the Plan Presentation Tools dialog opened, it was necessary defined the 

name of the Plan presentation, and the corresponding parent task. In this case, the 
author decided to name the view according operational instructions from A.N.A.S to 
encode works and relative files, in order to obtain a unique identification and make 
easier the interpretation.   

 

 
              Figure 5.24- Elaborate Code - Reference Table (A.N.A.S) 
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For all the presentations the first and the second level codes (MACRO project code 
and field code) were the same:  

        P00: Because it is about a unique main project, the creation of Variante di 
Demonte (Main axis project)  

       VI01: Because are representations of the first Bridge (Perdioni) of the project. 
The third level (discipline code) changed according the discipline the 

representation was assigned to. Two code were used: 
       ARC: for the architectonic view 
       MAN: for the view related to the maintenance plan 

                The four level define the view’s characteristic. Three code were used: 
       PP: for the planimetric views 
       RN: for the rendering or perspective views (3D) 
        

               The name view for the plan presentation was: P00 VI01 ARC PP01.  
 

Then, the source features to represent in the view were selected. There are two 
methods to select the feature: Select the object one by one or using Dynamic query. In 
this case, it was more convenient to use the Dynamic query; when the user selects this 
option the follow window was opened: 

 

 
            Figure 5.25- Dynamic Query by Tasks 

 
It was possible decided if select from task, features or location. Because the entire 

project should be represented the more convenient way to select the feature was by 
Task, and the import bridge model file and the Civil3D Connector were selected. The last 
step was selecting the drawing rule and finishes the process. Finally, the Presentation 
view was stored in the explorer in Novapoint.  
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        Figure 5.26- 2D view, Plan Presentation P00 VI01 ARC PP01 

 

             5.5.3.2  3D Presentation  
 

The path followed to obtain a 3D Presentation was very similar to the case of Plan 
Presentation. 

View > 3D. 
 

 
       Figure 5.27- View ribbon 

 
The author decided to create three 3D presentations.  One in which the whole 

model was represented with the correct texture. And two 3D presentations in order to 
represent the Maintenance Program, one for the Performance Subprogram and the 
other for the Control Subprogram. 

For the 3D Presentation of the entire model, as source features were selected the 
IFC bridge file and the Civil3D Connector.  At this point the author encountered with a 
problem, the elements with an attachment file did not showed in the correct way, so to 
solve this problem, a new drawing rule was created. The new rule was named 
Presentation 3D Model, and was based to the Default drawing rule, because the author 
was conformed with the texture showed for each element with this rule. 
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View > Drawing Rule Editor 
 

 
            Figure 5.28- Drawing Rule Editor 

A dialog box with a list of all the Drawing rules was opened, and the rule named 
Default was selected and copied.  Then the properties of the new rule were edited, to 
show the element of the representation in an accuracy way.  

 

 
             Figure 5.29- 3D presentation P00 VI01 ARC RN01  

To manage the 4D by using Novapoint, the idea was to create attributes that 
represent a very precise phase and create a special Drawing Rule that represent the 
elements based on these specific attributes. 
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Two drawing rules had to be created, one for the control subprogram and one for 
the performance subprogram. 

The attributes used for the new rules were the attributes created in the conversion 
rule for the IFC bridge model file, the Element Code for the performance subprogram 
and the Control Code for the control subprogram.  

View > Drawing Rule Editor > New 
 
Before starting with the creation of the rules, it was necessary named the new 

rules, in this case: Control Subprogram Rule.  In the tab All Objects a new node was 
created: Codice Controlli, and in this new node three node were added, one for each 
frequency of control: “Ogni 12 mesi”, “Ogni 6 mesi” and “Ogni mese”. Then was 
necessary to define the attribute condition from each of them: the attribute type, the 
operator (“Equal” in case of just one value of the attribute, and “in” in the opposite case), 
the attribute value type (string), the value(s) this will be the filter,  the name attribute 
(propertyName) and the name value (Codice Controllo) this will be the attribute that the 
software will search. Finally, a color for each frequency was assigned.  

The same procedure was carried out for the Performance Subprogram rule. 
 

 
            Figure 5.30- Drawing Rule created for Control Subprogram 

Once the rules were created, it was possible to generate the 3D presentations. In 
both cases, the feature selected was the IFC bridge model, because for the purpose of 
these presentations it was not necessary to represent the terrain surface; the summary 
task selected to contain the presentations was: /90 PRESENTATION and the subtask: P00 
VI01 MAN. 
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The names of the presentations follow the A.N.A.S code, the performance 
subprogram was named with the code: P00 VI01 MAN RN01, and for the control 
subprogram the code was: P00 VI01 MAN RN02. 

Lastly, the Presentation rule tab was completed with the drawing rule 
corresponding to each case. 

The 3D presentation created was showed in the explorer, with a double click on 
the name the presentation will open. 

 

 
        Figure 5.31- 3D presentation of the Performance Subprogram – P00 VI01 MAN RN01  

If the Presentation Setup is open, it is possible show or hide the different class. 
 

 
         Figure 5.32- 3D presentation of the Performance Subprogram: Elements with control every six months  
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                     5.5.3.3 Publish and Maps 

These commands were used to publish the model presentations created by using 
Novapoint in Easy Access, which will allows carry out the BIM communication. 

Output ribbon > In the section Publish to Easy Access: Maps (for Plan Presentations) or 
Presentations (for 3D). 

 

 
         Figure 5.33- Output ribbon, buttons to Publish 

The dialog that popped up let the user choose from a list of 3D /2D presentations 
task to distribute. Then views were available in the Easy Access Presentation view, 
marked with date and time. The LOD displayed in presentations depends on the camera 
viewpoints with which they were published. To open a presentation from the list, just 
click on a view.  

In this thesis, were published three 3D presentation (P00 VI01 ARC RN; P00 V01 
MAN RN01; P00 VI01 MAN RN02) and one Plan Presentation. (P00 VI01 ARC PP). 

 
The cloud base solution is very useful in case of large and collaborative projects, 

because in these cases it is not practical to search model information by using Novapoint. 
In addition, the information size would be heavy and would generate the slowdown of 
the program. 

 
        Figure 5.34- Process that follows the information when the user publishes presentations from Novapoint to     Easy   
Access.13 

                                                           
13 Modified figure from an image taken from Novapoint - Quadri Tutorial: New features in Quadri 

Easy Access 
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Brotle compression in Novapoint: Smaller file to unpload to Easy Access, Smaller 
file to download in browser in Easy Access 

Content Delivery Network: least amount of latency to download files 
Server Worker: the files are saved in browser cache after their intial dowload, the 

files are restored from the local cache, this allows quick drawing  
TrimBIM, this is a buffer posible top ut into memory directly, no (time demanding) 

parsing required.Useful to optimaze the process. 
 

  5.6 BIM Communication 

5.6.1 Quadri Easy Access: 
 

Is a web application, a communication platform.  Allows follow up the projects in 
everywhere. 

The steps that must be following to create the linkage are:  
Sigin in Quadri model > Select the project on the server and click on Enable Easy 

Access  
When the user loging in easy access (with the Trimble ID), can see all the projects 

that have access to. Then, the project of interest is chosen and the members that can 
uses it are selected. 

 

 
          Figure 5.35- Easy Access overview 

 

To use this platform provides an easy access to project information: 
- Project overview: general information;   
- Timeline: shows what, who and when changes or add something to the model;  
- Presentation: 3D presentation published from Novapoint Base, they are not 

dynamic but allows a 3D navigation and access to basic features properties;  
- Maps: 2D presentation published from Novapoint Base; 
-  Tasks: shows how the model is organized, by clicking in the task tree it is possible 

see date and time for when it was last executed; 
- Topics: communication around the model (possible clashes, checks, ask for or 

give information); 
-  Attachment: to add common documents, everyone with access can view or 

download the files, is an easy way of distributing files that have to do with the 
project, and also displays a list of exported reports. 
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-  User: overview of the users that have access to the Quadri Model 
The application requires to the user log in with the Vianova ID (is an account for 

everything that is doing online) 
 

          5.6.1.1 Presentations 
 

Once the presentations were published, them can be open in Easy Access. From 
easy access, it was possible to see the main feature of each element like the beam profile, 
the control and element codes and the link attached. At this point, one of the purposes 
of the communication objective was achieved, because the participants can enter to the 
link showed and modify the file, automatically this will also be changed in Novapoint. In 
this case the file attached contains information of the maintenance program, so the 
person in charge of this activity can open the file and indicate that the control of the 
specific date was done, also this person can add some comments. This allows the other 
members of the project to follow the evolution of the maintenance plan.  

 

 
           Figure 5.36- 3D Presentation (P00 VI01 ARC RN) in Easy Access 

          5.6.1.2 Topics communication  
 

The topics are a communication tool; they are related to the model data. It is 
possible to relate it with 3D presentation, create viewpoints and upload pictures to 
Novapoint. In the latest versions are available the options to create a market and an 
animation of the topics (if there are many viewpoints in a topic, a little video can be 
created to showed it). 

It is very useful to make comments on the model, without the need of use other 
program or application. 

The users can get access via Novapoint Base, mobile device or by web browser. 
The topics can be exported, imported, deleted or edited. To create a Topic it is 

necessary, first of all, to define the Topic Settings that contain the information that a 
topic could be tagged with.  
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This is a global setting for the project and will be active for all the new topics 
established: 

- Types: name for the different topic types the user want. 

- Labels: Set of possible labels that the user could mark the different topic with.  

- Priorities: Useful to define the level of significance of the topic. 

- Statuses: Possible status values to choose from to mark the topics 

- Users: This is read-only information 

- Clone Settings: It is possible to clone the topic settings of another project to 

which the user has access. 
 

 
            Figure 5.37- Topics Settings definition 

In this project, the author decided to create the follow Topic Settings: 
 Types: - Routine Maintenance; - Extraordinary Maintenance; - Question; - Detected 

Clash 
 Labels: -Colum; -Beam; - Guard Rail; - Pavement; - Abutment  
 Priorities: - High; - Normal; -Low 
 Statuses: -Active; -In progress; - Finished; -Not scheduled  

 
In order to obtain a better representation of the topic’s markets in the model, for 

each market type different icons were assigned and for each market status different 
colors. 

The topics can be created directly in Novapoint Base or in Easy Access. 
By way of example, to use this tool the author supposed the situation in which the 

person in charge of carrying out the routine maintenance need to communicate with the 
designer to ask for some position and dimensions.  

The creation of the topic was carried out following the follow steps: 
 

In Easy Access, in the tab Topics > Click the Create New Topic button 
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          Figure 5.38- Creation Topic window in Easy Access  

 

Then was necessary to complete the require information, the possible choices are 
predefined in Topic Settings. The tittle is the first information that will be showed in the 
topics; in this case the author completed the information with the follows values: 

 
- Types: Routine Maintenance 
- Labels: Column, because the maintenance person want to ask for this type of 

element 
- Status: Active, because is a new topic and at the moment there is not changes.  
- Priorities: Normal, because is just for ask information to corroborate the 

situation. 
- Assigned to: Usually this space is completed with other users, but in this case the 

designer and the maintenance person are the same user.  
 
After that a preview of the topic was available. The next step was click on Create 

Topics button, after this was possible to add comments and picture, change status and 
priorities. To add viewpoints and animations was necessary clicked on the Presentation 
tab and opened corresponding 3D presentation. Then in the topic’s column was available 
the option to add a viewpoint. When the viewpoint was added, it was also possible to 
draw in the picture. The animation was automatically generated, to see it the user must 
click on Play Viewpoints. 
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                                                                          Figure 5.39- Example of Topics Communication  

The created topic was instantaneously updated in Novapoint Base, so the designer 
could respond immediately. The interface is almost identical to what is seeing in the web, 
but here there is the possibility to create a market in the project. To add the market, it 
was necessary click on the Add Market button, and then click in the element in which 
the market will be located. The result was a market represented with an icon 
corresponding to the type topic and with a color according to the status of the topic. 

 

 
               Figure 5.40- Topics communication (with markets) in Novapoint Base 

If any participant of the topic changes the status or the priority, the color will 
change. This was an interesting way to know with a quickly look the status of the topic.   

Usually in a project there are many topics, both Novapoint and Easy Access allow 
to sort them according several classifications: Create Date, Modified Date, Tittle, Type, 
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Author, Assigned to, Status and Priority. In this way becomes easier to search the topic 
of interest. Another tip to consider is the fact that the topics in which the user 
participates are showed with a blue title. However, the better way to search the topics 
was to start typing what the user are looking for in the search box, it is possible to 
combine various parameters of search. Continuing the same example above, if the 
maintenance person wants to search an old topic to verify some information, in the 
search line must write the key words and matches with the corresponding classification.  

 

 
                                                     Figure 5.41- Topics search example  

Then, only the topics with these characteristics are showed in the list. 
To create a new topic from Novapoint Base, the procedure was the same, but was 

necessary are signed in with the Trimble ID and to activate the Topics Pane from the view 
ribbon, then the topics pane automatically showed the topics for the project. 

 

 
                                               Figure 5.42- Procedure to open the topics pane 

In Novapoint Base, it was possible to add a market for the topic and configure the 
colors for the priority or status. 

In the example, once the “designer” responds the question asked by the 
maintenance person, decided to add a market in the respective element. In this case, the 
icon showed correspond to the type: Routine Maintenance (a little schedule) and the 
color of the balloon was yellow, because at that time the priority of the topic was Normal.   

Finally, when the “maintenance person” obtained the answers that needed, 
changed the status from Active to Finished and the priority from Normal to Low, because 
of this the market is green now.  
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                                        Figure 5.43- Topics List  

5.7 BIM Collaboration 

This is a fundamental part of Novapoint uses, with the function of share and receive 
it is possible to put all the information in a central model anytime through Internet, in 
this way the project continuously has a central model that is up to date hour by hour, 
day by day. The members are informed about these changes in a detailed and 
transparent way. 

In this part of the thesis, the author received information from another student 
that is working with a part of Variante di Demonte project and who uses software 
different from the one used for this thesis, as OpenRoads and Revit. Before to start work, 
it was fundamental to establish the coordinates and the file which would be used, to 
avoid coordination problem. However, in case of coordination problems, the software 
allows to act on the positioning of some types of imported model, for example in for the 
IFC file it is possible to adjust the imported settings under Assign Global Coordinate. 

 

 
        Figure 5.44- Collaboration flow to obtain a model of the entire project 
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                5.7.1Share 
This action is the one that allows to share the changes to the Quadri Model, the 

features and tasks in the workset are in sync with the shared model (server), and so that 
others member of the project can receive the changes. It is important to share 
periodically, because if the workset (binder) has been damaged the user do not loses the 
work because all the information will be in the cloud. (central model). 

Home tab > Trimble Quadri > Share 
At this point, there are two options: share all the changes, or select the task and 

the object to share. If the user decided to select the task to share, also the tasks 
associated with this will be shared. 

 

 
                      Figure 5.45- Selection window of the tasks to share  

After, clicking Finish it was possible to see how many task and object will be shared. 

                5.7.2 Receive 
This function is used to update the workset with the changes that other users have 

med to the shared model (server), in order to sync the task and the features in the 
workset with what the others team members have. In this case, it was used to receive 
the information of the second part of Variante di Demonte. 

Home tab > Trimble Quadri > Receive 
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Figure 5.46- Receive changes dialog box 

It was possible to decide when and what changes receive, if all of them or the 
changes shared in a specific date. The author decided to receive the information related 
to the corridor of the second part of the project, which include a small bridge (Cant) and 
a tunnel, in addition the alignment was received to verify if we both worked with the 
same information. 

 
Figure 5.47- 3D view of the Variante di Demonte complete corridor2D 

 
               Figure 5.48- 2D view of the Variante di Demonte complete model in Easy Access 

It was possible to generate tables that contain information of the entire model or 
of a selected task. From the customize table tab, the properties to show and the way in 
which the information will be displayed can be setting. In addition, selecting the 
alignment it was possible to obtain the cross sections, which it is very useful to 
understand how the project develops. As negative aspect this command can only be 
used for the elements modeled by using Novapoint. 
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            Figure 5.49- Cross section - station 0+365  

 As aforementioned, once the user share and release a task, this can be reserve 
by another person who can modified it.  In this thesis, not changes were carried out. 

Finally, it was obtained a complete representation of the Variante di Demonte 
project. 

                As a comment, the corridor imported from OpenRoads it is displayed as a solid 
element, so the representation it was much clear that the corridor imported from Civil3D, 
the reason might be OpenRoads allow to export this element in an IFC format. 

  5.8 SIMULATION 

  5.8.1 Tekla 4D 
 

Since the result obtained with Novapoint to administrate a 4D BIM model was not 
very satisfactory, the author decided to insert the time schedule for the maintenance 
plan by using Tekla Structures. 

Tekla offer a potent tool for time management.  In the ribbon of the home page 
there is a tab named “Manage”, and it is possible to found tools like: Phase, Task Manage, 
Project Status, Clash Detect, Organizer, Sequencer, etc.  

 

 
          Figure 5.50- Manage ribbon 

  5.8.1.1 Working methodology 

In this thesis, in order to attach the maintenance program to the bridge model 
were used several of the tools above-mentioned. The goal of this section was to obtain 
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a customizable model view and comprehensive 4D simulation of the progression of the 
maintenance plan. 

 

 1) Creation of the maintenance program calendar  
Before started linked the model with the maintenance date, was necessary to 

create de maintenance schedule. This schedule was created considering the 
maintenance program created in the section 5.5.2.1, and assuming the bridge 
construction will be completed by 1st September 2020. It must be clarified that the 
scenario created for the schedule follows the Control Subprogram tasks. 

 

   2) Filter Object  
It was created a filter for each main group of elements that composes the model: 

Columns, Column Header, Abutments, Guard Rail and Beam.  
The filters were used to restrict what could be selected or what was visible in a 

view. 
Object Group- Selection Filter > New Filter> Add row 

 

 
                            Figure 5.51- Object Group, example: Column filter 

Each row was a rule that defined which objects should be included or excluded.  In 
the Category list, it was selected the object category in this case: Part, but also different 
options were available like:  Task, Component, Assembly, and so on. In the Property and 
Condition list it was selected the suitable object property and condition respectively. 
Finally, the Value list was completed with a value according to the property selected, and 
the selection filter option in the filter type was marked. 

The same procedure was followed for the other groups of elements. 
 
 3) Phase Manager 
This tool was used to break the model up into sections. Usually, the phases are 

used to indicate the erection sequences, but in this case were used to indicate the 
different priorities in which the maintenance plan will be develop. Because of the long 
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extension of the bridge, the author supposed the control will be carry out by different 
sectors. 

 

 
                            Figure 5.52- Maintenance priority table  

Manage tab > Phases > Add 
To select the elements that compose each phase were used the filters created in 

the previous section, this allowed save a lot of time and facilitate the selection. So, for 
example in the case of Priority 1, it was activated the filter Columns and only the columns 
were visible and selectable, to add the elements to the phase the user must select the 
elements and click on “Modify phase”, then to observe what object were included in the 
phase click on “Object by phase”. 

 

 
Figure 5.53 - Phase Manager - Object of priority 1 

 4) Task Manage 
Task manager allows to incorporate time-sensitive data into 3D Tekla 

Structures models and to control the schedule at various stages and levels of detail 
throughout the project. With Task manager was possible to create, store and manage 
the scheduled tasks, and link the tasks to their corresponding model objects.  

The tasks can be imported from external project management tools such as 
Microsoft Office Project or Primavera P6, and with Task Manager the user can 
supplement the imported schedule with more details. 
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In addition, as the tasks are created the software automatically generate a Gantt 
chart. 

The first step was the creation of two scenarios, in order to define the workflows: 
ERECTION (this was created just as example to obtain the end date of the construction) 
and MAINTENANCE PLAN. Each scenario contains the relative tasks.  

Click Manage on the ribbon > Tasks > Add Scenario  
To add the tasks, the scenario must be opened. Five principal tasks were created, 

one for each type of control: GUARDRAIL, ABUDMNETS, FONDATION, COLUMNS, 
BEAMS, and PAVEMENT. Then were added the different subtask which were created 
according the division of the labor in which the maintenance program will be carry out. 

Create Task > Create Subtask (when the user clicks this button, the task in which 
the subtask will be add must be selected)  

Once all the tasks and subtasks were created, it was possible to add the object of 
the model with will be linked, to do this the phases created before were used. For 
instance, to add the elements for the first subtask of the COLUMN task, the phase 
manager window was opened and the phase Priority 1 was selected (Objects by phases), 
then turning to the task manager window: right click on the subtask > Add selected 
objects 

This procedure had been followed for each subtask. 
 

 
        Figure 5.54- Maintenance Plan Scenario  

tasks, the black symbol indicates the task is a summary task that contain subtask, 
the blue symbol indicate that the subtask is linked with objects of the model and contain 
planned start and end dates. The complete schedule is available on the appendix D. 

The software allows defining plenty of parameter to each task, from general 
properties to production rate or additional information. However, considering the goals 
for this section just the parameters useful for the implementation of the maintenance 
program were completed: General Properties, Planned Scheduled and Dependencies.  

Right click on the task/subtask > Task Information 
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Figure 5.55- Task Information window 

The planned start and end date information for each task was completed according 
the calendar created in the point 1). In certain situations, it was necessary to create 
dependencies between the tasks or the subtasks. For instance, the GUARDRAIL must be 
controlled each month, so each subtask of the guardrail task is related, so as example 
the second control cannot start if the first control did not complete. 

Also, the non-working (holidays and weekend) periods were defined as well as the 
hours of the working day.  

 

 
         Figure 5.56- Definition of the non-working periods 

 5) Project Status Visualization 

The Project Status Visualization tool is uses to review the status of model objects 
in a specific time frame. 

In this thesis was used to display the maintenance schedule, using different colors 
to identify the groups that already been checked and the groups that are being 
controlled at the current time. So, in this case the project visualization was based on 
tasks.  

Before to create the project status visualizations, it was necessary to define the 
Object Group and the Object Representation. 

 
 



5. MAINTENANCE PLAN - BIM COMMUNICATION 

102 | Page 

                Objects Groups 
The objects groups are filters, the procedure for its creation was the same 

explained in the section 5.10.1.2, but in order to obtain a visual representation of the 
maintenance program the option “Task” was selected as Category, and as Property: 
Planned start date and Planned end date. 

Three objects groups were created with the aim of understanding until what part 
of the control program was carried out at the moment of the selected date: IN CONTROL, 
CONTROL COMPLETED and ALL.  Both, in control and control completed objects groups, 
contained two rules: one for the “Planned start date” and the other for “Planned end 
date” Property and the same Value: “Review date” 

The Conditions for each group were different, for IN CONTROL was “Earlier than or 
equal” for the start date, and “Later than or equal” for the end date.  This mean if the 
task starts before or in the same day of the review date and finish after or in the same 
day of the review date, the elements of this task will be selected. For CONTROL 
COMPLETED, in the two rules the Condition was “Earlier than”, so all the elements of the 
task that start and finish before the review date will be selected. 

The third group: ALL, was created in order to represent the elements of the task 
that had not yet been controlled. In this case, as Category the option “Parts” was 
selected, as Property “Name” and as Condition “Equals”. 

Each group was saved with the options View Filter, Selection Filter and Object 
Representation, on a filter type activated.   

 

 
                    Figure 5.57- Object Group, example: task in control filter 

                Object Representation 
Before to create the project status visualizations, were defined the colors and 

transparency settings for the object groups. 
Two object representations were created, for the maintenance plan and for the 

erection (once again, as example). 
The colors chosen were: Blue for the completed task and green for the ongoing 

task. The author decided to use grey for the not yet controlled elements, with 70% of 
transparency. The elements that were not included in any task were hidden.  
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      Figure 5.58- Object Representation for the maintenance plan scenario 

                      Visualization 
Once the object representations were created, it was possible to simulate the 

project status of the maintenance plan.  
Click on Manage tab > Project status 

 

 
                                               Figure 5.59- Review Date of the visualization 

The Project Status Visualization dialog box was opened and the visualization 
settings were modified. In the object representation list, it was selected the object 
representation created for the maintenance plan. 

Also, it was defined the start and end date for the time scale slider, as well as the 
time step. The scale start date selected was two days before the first maintenance 
control: 29.09.2020, and the scale end date was one years later of the end of the 
construction: 01.09.2021. 
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Before save the visualization settings the box Refresh view automatically was 
selected.  

Finally, as the review date changes, the user can interpret the status of the 
maintenance plan. 

 

 
          Figure 5.60- Project Status Visualization day: 18/06/2021 

It is possible to create a report of the parts that are selected in the review date.  
 

5.9 Synchro Pro  

Synchro PRO is an advanced software that allows to work in real time with 4D 
functionality, to plan, manage and communicate the projects. With this program it is 
possible to do many interesting things for example compare two different scenarios 
(what-if: comperes two situation, like planned date and actual date) using the base lines 
schedules or add the cost parameter. A very positive aspect is that support a big number 
of files from different sources. It can be used as a “door” for the Facility Management of 
the project. 

 
 For this thesis, it was used in an attempt to obtain a better representation of the 

maintenance program sequence and prove the interoperability with Tekla Structures. 
 
Previous steps on Tekla 
 
The advantage of having worked the 4D model previously on Tekla, was the 

chronoprogram is already done and it was just necessary export it in the correct format 
(Microsoft Project XML file). To import the IFC file that contains the elements which will 



       InfraBIM and Interoperability: Maintenance plan implementation and BIM communication 

 

Page | 105 

be linked with the activities of the chronoprogram, the author decided to prove a 
powerful command, Organizer, that Tekla provides to managing model information.  

By using Organizer, a category named Maintenance Phases and several 
subcategories were created, each of them represents the phases in which the model was 
earlier divided. Because of that, the element selection did not claim much time. In the 
Organizer windows it is possible to see the properties (profile, material, height, phase, 
length, UDA, etc.) of the objects belonging to the subcategory selected. 

The objective for which the subcategories were created based on the maintenance 
phases, was to insert them a Zone Code. This code represents the divisions of the model 
according the parts and their location. The Zone Code was inserted as user defined 
attribute through a property category, consequently it was possible to export the code 
with the objects in IFC file.  

It is important to say, the code is just visible in the Organizer window, to see it in 
the User defined Attributes dialog box it is necessary to add it in the objetcs.inp file. The 
next step was to add the custom property (zone code) in the category property. Then it 
was possible to set the zone code value for each subcategory.  

 

 
      Figure 5.61- Category Properties window, insertion of the created parameter  

To write the values to the model objects it was executed the Synchronize category 
button. The last step was to add the classification code to the project properties: Project 
Properties > Attributes > User-Defined attributes > Classification system (it was written 
the name of the code created: Zone Code), this made the attribute visible on the Export 
setting. As explained in the section 4.5, it was created a Property Set Configuration where 
was only selected the properties needed for the maintenance plan implementation in 
Synchro Pro, such as: Name, Profile, Zone Code, IfcType, Material, Phase and so on. 
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Use of Synchro 
 
Once the IFC file and the XML file were exported, it was executed the importation 

in Synchro. The XML file was imported smoothly, by contrast the IFC format required a 
little intervention because the IfcReinforcement and IfcRebar elements were displayed 
as very long lines. To fix this problem, the author decided to delete these types of 
elements due to are not necessary for the maintenance control. The elements imported 
are showed as Resource. 

 

 
       Figure 5.62- Resources window (element imported)  

The elements were linked to the associated task automatically by using an 
automatching command named: Perform Resource to Task Automatching. This 
command allows to use parameters or customer field to link the 3D model with the 
schedule. To use this process, a custom column with the zone code had to be created on 
the resources, and also added a column with this parameter to the tasks. It was necessary 
to assign the code corresponding to each task. After that, it was possible to create the 
rule with the expression to match the elements with the tasks. 

The software searches the objects according this code and added them to the 
activity that has the same code value. It is possible to see what elements have been 
assigned to each task. 
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                         Figure 5.63- Rule created for the link 

Finally, to carry out the simulation, the options Maintenance was chosen as 
appearance profile. (Other options are Install for the erection, Temporary and Remove 
for the demolition). For the simulation it was possible to define the camera position, as 
well as, the scale of time that represent a second in the different schedule parts. As 
mentioned, the software has a great potential for the model management, here it was 
just applied for a little demonstration.  

 

 
        Figure 5.64-Fragment of the simulation: day 10/03/2021 

Compared with the Tekla simulation, Synchro shows in conjunction with the video 
the progress on the Gantt chart which allow to have a clear interpretation of the 
development of the maintenance plan. 
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       Figure 5.65- Video Synchro PRO maintenance plan simulation 

 
                                                                   Figure 5.66 - QR code of the video 

The simulation of the maintenance plan obtained with Tekla Structures and 
Synchro PRO, it will be useful to program futures activities such as repairs, interventions 
or road closing and evaluate their impacts on the schedule. All this information will be 
valuable to take important decisions.  
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            5.10 Chapter discussion 
 

Novapoint is a new software that actually is gaining ground in the market of 
infrastructure software, due to all the advantage that offer.  

Working with Novapoint did not bring major complications, even if it was an 
unknown software for the author. The interface is user-friendly, which allowed learning 
quite quick how to uses it.  

The interoperability between Novapoint and Tekla was satisfactory. Novapoint 
support plenty of file extensions, from ortho photo, points clouds to DWG, SOSI, 
LandXML, etc. In this thesis, the author imported .LandXML, .dwg and .IFC files.  In all 
cases it was necessary to define a conversion rule which is the key to obtain the desired 
importation. 

The interoperability between Novapoint and Civil3D was also quite good, because 
of the Civil Connector command available in the software. However, it was expected to 
import the corridor with all its attributes, but only the features lines could be imported.  

The maintenance plan implementation was not carried out as had initially been 
expected, the 4D BIM model management by using Novapoint  just could be  realized 
through classification and visual representation , without add specific dates.  

The implementation of the time schedule on the bridge model was done by using 
Tekla Structures. Although the software provides the 4D tools principally for the 
construction or fabrication schedule, the author managed to use them to link each 
element with the maintenance plan calendar. It is important to clarify that the phases 
created by using Tekla, could have been created by using Grasshopper, as well as the 
parameter (codes) created through the conversion rule in Novapoint. 

The final result was very good, it was possible to see the evolution of the 
maintenance program over the time. Something that could be added in order to improve 
the representation of the 4D model is a tool that enables to create a short video with 
this information. On this way, would not be necessary to use other software such as 
Navisworks or Synchro to obtain this type of representations. Synchro PRO was used to 
create the video of the maintenance activities and test the interoperability with Tekla, 
despite the user-interface is not very friendly did not take long to learn the basics. The 
result of the visualization as well as the exchange of information with Tekla was very 
satisfactory. 

Furthermore, the whole package: Novapoint-Quadri-Easy Access composes a really 
good tool for the BIM Communication. 

Having used Quadri as model sever and collaboration platform allowed different 
disciplines (in this case two students) to work together in a same model, achieving a 
common understanding of the project. Each user could see what the current data was, 
avoiding to work with non-update or incorrect data. 

It was possible to see all the disciplines with 3D details in simultaneously, seeing 
how everything is connected and playing together, and analyse what will happen with 
the work environment when someone make changes. All those things were a big 
advantage, because allowed to detect collisions with things performed by other users 
and quickly make changes if necessary, compared with years ago, when the users were 
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working separately and often could be taken aback when they finally put together all the 
drawings. 

Another great advantage to getting everything into Quadri, is the users can bring 
the model with them in each moment (on the cellphone, tablet or computer) through 
Easy Access. It is important to highlight the fact that by using Easy Access was not 
possible to modify the model, it is just to display it (3D navigation) and read some 
information or open an attachment link. The author found the topics communication 
very useful, especially when the controls are under way because allows a fast 
communication between the participants (some in the office and some on the site of the 
project), with the addition of an exactly localization of the issues.  

 

 
 

             Figure 5.67- Level of satisfaction achieved in the last part of the thesis 
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6 CONCLUSION and FUTERE DEVELOPMETS 
 

The principal objective proposed for this thesis was to demonstrate how the use 
of an innovative methodology, as is the BIM, brings plenty of advantages in all the 
projects stages. 

The main topic was focus on the implementation of the bridge maintenance plan 
through the application of BIM methodology in a real case: Variante di Demonte, based 
on the executive project information developed with the traditional procedure.  

Starting from a general framework of the project, by using an authoring software 
as is Civil3D, it was possible to extract information for the definition of the structural 
model through a parametric modeling software: Grasshopper. Once the 3D model was 
generated, using also Tekla Structures for the details, it could be analyzed its use for the 
implementation of the maintenance plan and its interoperability with the several 
software chosen.  

The level of detail applied was the necessary for the implementation of the 
maintenance program, which means that can be increased. However, it was created an 
important database which was suitable for the sharing and consequent modification or 
deepening of the model. After the modeling and georeferencing of the major work, it 
was continued with the coordination.This part, it was carried out using as collaborative 
platform the entire package that Novapoint offers. This platform allowed to define the 
federated model, joining the structural part and the context part in a central model. In a 
future, other disciplines can be added (for example: everything related with the MEP) 
and others phases of the project can be regarded, with the purpose of obtaining a really 
complete database. The concept OpenBIM it is very important, although it has advanced 
a lot in the last years still has much to improve in order to exchange information without 
losing any detail or quality. 

The subsequently definition and management of the 4D Model was carried out as 
a deepening of the 3D Model, where the geometric and time parameters were 
interconnected.  

In general, the results obtained has been satisfactory (except for the 4D handling 
by using Novapoint), however they can still be improved.  

It could be shown how the modification in the central model impact in the 
coordinate model, thus also in the documents obtained from this. So, the information is 
updated automatically (after sharing it) when a member change something, which allows 
have a control of the characteristics of the project. To work in a collaborative platform, 
brings the possibility to create different hypothesis for the project and evaluate different 
situations that can impact in the economy and performance thereof. 

From the model created it was possible extract information in table format with 
the nomenclature used for the elements, the quantities and the principal parameters. 
Furthermore, it was possible to extract reports from the 4D Model, for example a list of 
the elements that have been or will be controlled in a specific day. In addition, if the user 
wants can extract 2D or 3D plans of the entire model or of a specific part, and create 
several views to show different aspects of the model. It would be very difficult to carry 
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out these activities with the traditional method(manually), so in this way it saves time 
and the human errors are reducing.  

The realization of the 4D model and its simulation allowed an immediate 
understanding of the planned activities, that facilitates to study and analyse the logistics 
of the project. This is difficult to interpret with just the Gantt Chart. 

The fact that the author did not have a previous knowledge of BIM methodology 
and consequently of the related software, meant a personal challenge and a great 
demand of time of learning. During the development of the thesis arose some difficulties 
nevertheless, in the vast majority of the cases were successfully resolved without 
compromising the basic principles of the methodology.  

It is important to note that more knowledge the user has of the methodology and 
of the potentially of the software, the benefits will be greater. For this reason, it is 
important count on the support of the Governments, University and companies to 
promote the BIM, which is highly likely that in a few years replace the tradition way to 
work in the engineering field. 

The issues dealt in this thesis was concentrated just in a part of the BIM 
methodology application. With the result obtained, other point of the methodology can 
be worked bringing benefits in other aspects of the construction. The created model 
serves as a first base to develop the Facility Management of the project.  
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A. Scripts 
 
 

 
Figure A.1- Longitudinal Beams Script 
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Figure A.2- Cross Beams Script 
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Figure A.3- Fist Diagonal Beam Script 
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Figure A.4- Second Diagonal Beam Script 
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Figure A.5- Pavement and Curb Script 
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Figure A. 6- GuardRail Script 

 
Figure A.7 - Tekla Points and Abutment insertion Script for the first abutment 
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Figure A.8- Script for the column 1 and 2 postion 
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Figure A. 9- Rectangular foundation script for column 1 and 2 
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Figure A.10- Column 1 Headers Script 
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Figure A. 11- Piles Script for column 1 
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B. Reinforcement details 

 
Figure B. 12- Top of the column reinforcement detail 

 
 
 

 
Figure B. 13- Lateral Panel of the abutment Reinforcement detail 
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Figure B.14- Abutment bottom part reinforcement details 
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C. Maintenance Plan complete file, example: Column 
 

 
                Figure C .15- Sheet 1- Element:  Description 

 
        Figure C.16- Sheet 1 - Element: Use Manual 

 
        Figure C.17-  Sheet 1 - Element : Maintenance Manual 
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Figure C.18 - Sheet 2 - Maintenance Program 

 

 
Figure C.19 -Sheet 3 - Control Comments: Planned control dates 
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D. Maintenance Schedule 
 

 
Figure D. 20- Maintenance Schedule by Tekla 
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 Figure D.21- Maintenance Schedule and Gantt chart by Synchro PRO 
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